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Notice 
1. All information included in this document is current as of the date this document is issued. Such information, however, is 

subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to 
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website. 

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights 
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights 
of Renesas Electronics or others. 

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. 
4. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by 
you or third parties arising from the use of these circuits, software, or information. 

5. When exporting the products or technology described in this document, you should comply with the applicable export control 
laws and regulations and follow the procedures required by such laws and regulations.  You should not use Renesas 
Electronics products or the technology described in this document for any purpose relating to military applications or use by 
the military, including but not limited to the development of weapons of mass destruction.  Renesas Electronics products and 
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
which it is not intended without the prior written consent of Renesas Electronics.  Renesas Electronics shall not be in any way 
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written 
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a 
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because 
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable 
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS 
Directive.  Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with 
applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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1. These materials are intended as a reference to assist our customers in the selection of the Renesas 
Technology Corp. product best suited to the customer's application; they do not convey any license 
under any intellectual property rights, or any other rights, belonging to Renesas Technology Corp. or 
a third party.

2. Renesas Technology Corp. assumes no responsibility for any damage, or infringement of any third-
party's rights, originating in the use of any product data, diagrams, charts, programs, algorithms, or 
circuit application examples contained in these materials.

3. All information contained in these materials, including product data, diagrams, charts, programs and 
algorithms represents information on products at the time of publication of these materials, and are 
subject to change by Renesas Technology Corp. without notice due to product improvements or 
other reasons.  It is therefore recommended that customers contact Renesas Technology Corp. or 
an authorized Renesas Technology Corp. product distributor for the latest product information 
before purchasing a product listed herein. 
The information described here may contain technical inaccuracies or typographical errors. 
Renesas Technology Corp. assumes no responsibility for any damage, liability, or other loss rising 
from these inaccuracies or errors. 
Please also pay attention to information published by Renesas Technology Corp. by various means, 
including the Renesas Technology Corp. Semiconductor home page (http://www.renesas.com).

4. When using any or all of the information contained in these materials, including product data, 
diagrams, charts, programs, and algorithms, please be sure to evaluate all information as a total 
system before making a final decision on the applicability of the information and products.  Renesas 
Technology Corp. assumes no responsibility for any damage, liability or other loss resulting from the 
information contained herein.

5. Renesas Technology Corp. semiconductors are not designed or manufactured for use in a device or 
system that is used under circumstances in which human life is potentially at stake.  Please contact 
Renesas Technology Corp. or an authorized Renesas Technology Corp. product distributor when 
considering the use of a product contained herein for any specific purposes, such as apparatus or 
systems for transportation, vehicular, medical, aerospace, nuclear, or undersea repeater use.

6. The prior written approval of Renesas Technology Corp. is necessary to reprint or reproduce in 
whole or in part these materials.

7. If these products or technologies are subject to the Japanese export control restrictions, they must 
be exported under a license from the Japanese government and cannot be imported into a country 
other than the approved destination. 
Any diversion or reexport contrary to the export control laws and regulations of Japan and/or the 
country of destination is prohibited.

8. Please contact Renesas Technology Corp. for further details on these materials or the products 
contained therein.

1. Renesas Technology Corp. puts the maximum effort into making semiconductor products better and 
more reliable, but there is always the possibility that trouble may occur with them. Trouble with 
semiconductors may lead to personal injury, fire or property damage. 
Remember to give due consideration to safety when making your circuit designs, with appropriate 
measures such as (i) placement of substitutive, auxiliary circuits, (ii) use of nonflammable material or 
(iii) prevention against any malfunction or mishap.

Keep safety first in your circuit designs! 
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IMPORTANT INFORMATION 

READ FIRST 

• READ this user's manual before using this emulator product. 

• KEEP the user's manual handy for future reference. 

Do not attempt to use the emulator product until you fully understand its mechanism. 

Emulator Product: 

     Throughout this document, the term "emulator product" shall be defined as the following 
products produced only by Renesas Technology Corp. 

• Emulator 
• User system interface cable 

The user system or a host computer is not included in this definition. 

Purpose of Use of the Emulator Product:  

     This emulator product is a software and hardware development tool for systems employing the 
Renesas microcomputer.  This emulator product must only be used for the above purpose. 

Target User of the Emulator Product:  

     This emulator product should only be used by those who have carefully read and thoroughly 
understood the information and restrictions contained in the user's manual. Users are required to 
be familiar with the basic knowledge for the electric circuits, logic circuits, and microcomputers. 

Precautions to be Taken when Using This Product:  

1. This emulator is a development supporting unit for use in your program development and 
evaluation stages. In mass-producing your program you have finished developing, be sure to 
make a judgment on your own risk that it can be put to practical use by performing integration 
test, evaluation, or some experiment else. 

2. In no event shall Renesas Solutions Corporation be liable for any consequence arising from the 
use of this emulator. 

3. Renesas Solutions Corporation strives to renovate or provide a workaround for product 
malfunction at some charge or without charge. However, this does not necessarily mean that 
Renesas Solutions Corporation guarantees the renovation or the provision under any 
circumstances. 
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4. This emulator has been developed by assuming its use for program development and 
evaluation in laboratories. Therefore, it does not fall under the application of Electrical 
Appliance and Material Safety Law and protection against electromagnetic interference when 
used in Japan. 

5. Renesas cannot anticipate every possible circumstance that might involve a potential hazard.  
The warnings in this user's manual and on the emulator product are therefore not all inclusive.  
Therefore, you must use the emulator product safely at your own risk. 

6. This emulator does not conform to safety standards such as UL or IEC. Be careful when you 
take this emulator overseas. 

Limited Applications:  

     This emulator product is not authorized for use in transportation, vehicular, medical (where 
human life is potentially at stake), aerospace, nuclear, or undersea repeater applications. Buyers of 
this emulator product must notify Renesas Technology Corporation, Renesas Solutions 
Corporation or an authorized Renesas Technology product distributor before planning to use the 
product in such applications. 

Improvement Policy:  

     Renesas Technology Corp. (including its subsidiaries, hereafter collectively referred to as 
Renesas) pursues a policy of continuing improvement in design, performance, and safety of the 
emulator product.  Renesas reserves the right to change, wholly or partially, the specifications, 
design, user's manual, and other documentation at any time without notice. 
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LIMITED WARRANTY 

      Renesas warrants its emulator products to be manufactured in  
 accordance with published specifications and free from defects in  
 material and/or workmanship. Renesas, at its option, will replace any  
 emulator products returned intact to the factory, transportation charges  
 prepaid, which Renesas, upon inspection, shall determine to be  
 defective in material and/or workmanship. The foregoing shall  
 constitute the sole remedy for any breach of Renesas’ warranty. See the  
 Renesas warranty booklet for details on the warranty period. This  
 warranty extends only to you, the original Purchaser. It is not  
 transferable to anyone who subsequently purchases the emulator  
 product from you. Renesas is not liable for any claim made by a third  
 party or made by you for a third party. 

DISCLAIMER 

      RENESAS MAKES NO WARRANTIES, EITHER EXPRESS OR  
 IMPLIED, ORAL OR WRITTEN, EXCEPT AS PROVIDED  
 HEREIN, INCLUDING WITHOUT LIMITATION THEREOF,  
 WARRANTIES AS TO MARKETABILITY, MERCHANTABILITY,  
 FITNESS FOR ANY PARTICULAR PURPOSE OR USE, OR  
 AGAINST INFRINGEMENT OF ANY PATENT. IN NO EVENT  
 SHALL RENESAS BE LIABLE FOR ANY DIRECT, INCIDENTAL  
 OR CONSEQUENTIAL DAMAGES OF ANY NATURE, OR  
 LOSSES OR EXPENSES RESULTING FROM ANY DEFECTIVE  
 EMULATOR PRODUCT, THE USE OF ANY EMULATOR  
 PRODUCT, OR ITS DOCUMENTATION, EVEN IF ADVISED  
 OF THE POSSIBILITY OF SUCH DAMAGES.  EXCEPT AS  
 EXPRESSLY STATED OTHERWISE IN THIS WARRANTY,  
 THIS EMULATOR PRODUCT IS SOLD "AS IS ", AND YOU  
 MUST ASSUME ALL RISK FOR THE USE AND RESULTS  
 OBTAINED FROM THE EMULATOR PRODUCT. 
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State Law:  

     Some states do not allow the exclusion or limitation of implied warranties or liability for 
incidental or consequential damages, so the above limitation or exclusion may not apply to you.  
This warranty gives you specific legal rights, and you may have other rights which may vary from 
state to state. 

The Warranty is Void in the Following Cases:  

     Renesas shall have no liability or legal responsibility for any problems caused by misuse, 
abuse, misapplication, neglect, improper handling, installation, repair or modifications of the 
emulator product without Renesas’ prior written consent or any problems caused by the user 
system.   

All Rights Reserved:  

     This user's manual and emulator product are copyrighted and all rights are reserved by 
Renesas.  No part of this user's manual, all or part, may be reproduced or duplicated in any form, 
in hard-copy or machine-readable form, by any means available without Renesas’ prior written 
consent. 

Other Important Things to Keep in Mind:  

1. Circuitry and other examples described herein are meant merely to indicate the characteristics 
and performance of Renesas’ semiconductor products. Renesas assumes no responsibility for 
any intellectual property claims or other problems that may result from applications based on 
the examples described herein. 

2. No license is granted by implication or otherwise under any patents or other rights of any third 
party or Renesas.  

Figures:  

     Some figures in this user's manual may show items different from your actual system. 

Device names:  

     Sections 1 to 6 of this user’s manual use H8/Tiny as an example of the device names. 
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SAFETY PAGE 

READ FIRST 

• READ this user's manual before using this emulator product. 

• KEEP the user's manual handy for future reference. 

Do not attempt to use the emulator product until you fully understand its mechanism. 

DEFINITION OF SIGNAL WORDS 

Be sure to read and understand the warnings below before using this emulator. Note that these are 
the main warnings, not the complete list. 

 This is the safety alert symbol.  It is used to alert you to potential personal  
 injury hazards.  Obey all safety messages that follow this symbol to avoid  
 possible injury or death. 

DANGER  DANGER indicates an imminently hazardous situation which, if not  
 avoided, will result in death or serious injury. 

WARNING  WARNING indicates a potentially hazardous situation which, if not  
 avoided, could result in death or serious injury. 

CAUTION  CAUTION indicates a potentially hazardous situation which, if not  
 avoided, may result in minor or moderate injury. 

CAUTION  CAUTION used without the safety alert symbol indicates a  
 potentially hazardous situation which, if not avoided, may result  
 in property damage. 

NOTE emphasizes essential information. 
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WARNING 
  Observe the precautions listed below.  Failure to do so  
 will result in a FIRE HAZARD and will damage the user  
 system and the emulator product or will result in  
 PERSONAL INJURY.  The USER PROGRAM will be  
 LOST.   

 1. Do not repair or remodel the emulator product by  
  yourself for electric shock prevention and quality  
  assurance. 

 2. Always switch OFF the host computer and user system  
       before connecting or disconnecting any CABLES or  
  PARTS. 

 3. Connect the connectors in the user system and in the  
      user interface cable by confirming the correct direction. 

 
 

CAUTION 
  Place the host computer and user system so that no 
cable is bent or twisted. A bent or twisted cable will impose 
stress on the user interface leading to connection or contact 
failure.  
  Make sure that the host computer and the user system 
are placed in a secure position so that they do not move 
during use nor impose stress on the user interface. 
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Introduction 

This manual describes the followings: 

• E7 emulator functions 

• Preparation before use 

• Debugging functions 

• Tutorial 

• Appendix (Components of the E7 Emulator, Window Functions, Command-Line Functions, 
Notes on High-performance Embedded Workshop, and Diagnostic Hardware Program) 

 
This manual does not intend to explain how to write C/C++ or assembly language programs, how 
to use any particular operating system or how best to tailor code for the individual devices. These 
issues are left to the respective manuals. 

Microsoft® and Windows® are registered trademarks of Microsoft Corporation.  

IBM is a registered trademark of International Business Machines Corporation.  

All brand or product names used in this manual are trademarks or registered trademarks of their 
respective companies or organizations. 

 

Document Conventions 

This manual uses the following typographic conventions: 

Table 1 Typographic Conventions 

Convention Meaning 

[Menu->Menu Option] Bold text with ‘->’ is used to indicate menu options  
(for example, [File->Save As...]). 

FILENAME.C Uppercase names are used to indicate filenames. 

“enter this string” Used to indicate text that must be entered (excluding the “” quotes). 

Key + Key Used to indicate required key presses. For example, CTRL+N means 
press the CTRL key and then, whilst holding the CTRL key down, 
press the N key. 

 
(The “how to” symbol) 

When this symbol is used, it is always located in the left hand margin. 
It indicates that the text to its immediate right is describing  “how to” 
do something. 
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Section 1   Overview 

The High-performance Embedded Workshop is a Graphical User Interface intended to ease the 
development and debugging of applications written in C/C++ programming language and 
assembly language for Renesas microcomputers. Its aim is to provide a powerful yet intuitive way 
of accessing, observing and modifying the debugging platform in which the application is running. 

The E7 emulator (hereafter referred to as the emulator) is a software and hardware development 
support tool for application systems using the H8/Tiny series, H8/Super Low Power series, or 
R8C/Tiny series microcomputer. 

The main unit of the emulator is connected through the dedicated debugging interface to the user 
system.  The user system can be debugged under the conditions similar to the actual application 
conditions.  The emulator enables debugging anywhere indoors or out.  The host computer for 
controlling the emulator must be an IBM PC compatible machine with USB1.1.  

This manual describes the contents that comply with versions of High-performance Embedded 
Workshop 4.0 or later. 

Figure 1.1 shows the system configuration using the emulator. 

Host computer

User system

Microcomputer
E7 connector

User system
interface cable

USB

E7 emulator

 

Figure 1.1   System Configuration with the Emulator 
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The emulator has three activation modes: 

1. A mode in which the emulator program is started after it has been downloaded to the target 
device: 

This mode is used when there is no emulator program in the flash memory of the target device. 

2. A mode in which the emulator program is started without downloading it to the target device: 

This mode is used when there is an emulator program in the flash memory of the target device. 

3. A mode in which the emulator is used as the flash memory writer: 

This mode is used when the emulator is used for programming the flash memory. 

The emulator provides the following features: 

• Excellent cost-performance card emulator 

Compactness and USB connection are obtained. 

• Realtime emulation 

Realtime emulation of the user system is enabled at the maximum operating frequency of the 
MCU. 

• Excellent operability 

Using the High-performance Embedded Workshop on the Microsoft® Windows® 98SE, 
Microsoft® Windows® Me, Microsoft® Windows® 2000, or Microsoft® Windows® XP operating 
system enables user program debugging using a pointing device such as a mouse. 

• Various debugging functions 

Various break and trace functions enable efficient debugging.  Breakpoints and break 
conditions can be set by the specific window, trace information can be displayed on a window, 
and command-line functions can be used. 

• Debugging of the user system in the final development stage 

The user system can be debugged under conditions similar to the actual application conditions. 

• Compact debugging environment 

A laptop computer can be used as a host computer, creating a debugging environment in any 
place. 

• The emulator can be used to program the internal flash memory. 
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1.1 Warnings 

CAUTION  
  READ the following warnings before using the emulator 
product. Incorrect operation will damage the user system and 
the emulator product. The USER PROGRAM will be LOST. 

1. Check all components against the component list provided at the side of the component box 
after unpacking the emulator. 

2. Never place heavy objects on the casing. 

3. Protect the emulator from excessive impacts and stresses.  For details, refer to section 1.2, 
Environmental Conditions. 

4. When moving the host computer or user system, take care not to vibrate or damage it. 

5. After connecting the cable, check that it is connected correctly.  For details, refer to section 3, 
Preparation before Use. 

6. Supply power to the connected equipment after connecting all cables.  Cables must not be 
connected or removed while the power is on. 
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1.2 Environmental Conditions 

CAUTION  
  Observe the conditions listed in tables 1.1 and 1.2 when 
using the emulator.  Failure to do so will cause illegal 
operation in the user system, the emulator product, and the 
user program. 

Table 1.1   Environmental Conditions 

Item Specifications 

Temperature Operating: +10°C to +35°C 
Storage: –10°C to +50°C 

Humidity Operating: 35% RH to 80% RH,  no condensation 
Storage: 35% RH to 80% RH,  no condensation 

Vibration Operating: 2.45 m/s2 max. 
Storage: 4.9 m/s2 max. 
Transportation: 14.7 m/s2 max. 

Ambient gases No corrosive gases may be present 
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Table 1.2 lists the acceptable operating environments. 

Table 1.2   Operating Environments 

Item Description 

Host computer Built-in Pentium® III or higher-performance CPU (1 GHz or higher 
recommended); IBM PC or compatible machine with USB 1.1/2.0 (Full-
Speed). 

OS Windows® 98SE, Windows® Me, Windows® 2000, or Windows® XP 

Minimum memory 
capacity 

128 Mbytes or more (512 Mbytes recommended) 

Hard-disk capacity Installation disk capacity: 200 Mbytes or more.  (Prepare an area at 
least double the memory capacity (four-times or more recommended) 
as the swap area.) 

Interface USB (USB1.1, full-speed)* 

Pointing device such as 
mouse 

Connectable to the host computer; compatible with Windows® 98SE, 
Windows® Me, Windows® 2000, or Windows® XP. 

Display Monitor resolution: 1024 x 768 or higher 

Power voltage 5.0 ± 0.25 V (USB-bus power type) 

Current consumption 100 mA (max) 

CD drive Required to install the High-performance Embedded Workshop for the 
emulator or refer to the emulator user’s manual. 

Note: This can be connected to the host computer supporting USB2.0. 
The USB interface does not guarantee the operation in combination with all the host 
computers, USB devices, and USB hubs. 
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1.3 Components 

Check all the components unpacking.  For details on the E7 emulator components, refer to the 
component list provided at the side of the component box.  If the components are not complete, 
contact our E-mail address for user registration or refer to the web site.   
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Section 2   E7 Emulator Functions 

This section describes the emulator functions.  They differ according to the device supported by 
the emulator.  For the usage of each function, refer to section 6, Tutorial.  This manual describes 
each function mainly using examples of the H8 microcomputer. 

2.1   Overview 

Table 2.1 gives a functional overview of the emulator. 

Table 2.1   Emulator Functions 

No. Item Function 

1 User program execution 
function 

• Executes a program with the operating frequency within a 
range guaranteed by devices. 

• Reset emulation 

• Step functions: 

Single step (one step: one instruction) 
Source-level step (one step: one source) 
Step over (a break did not occur in a subroutine) 

Step out (when the PC points to a location within a 
subroutine, execution continues until it returns to the calling 
function) 

2 Reset function • Issues a reset from the High-performance Embedded 
Workshop to the device during break. 

3 Trace function • Branch trace function incorporated in the device (four 
branches) 

⎯ Supporting this function depends on the device. 

4 Break functions • Hardware break condition 

⎯ Supporting this function depends on the device. 

• PC break condition (255 points) 

• Forced break function 
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Table 2.1   Emulator Functions (cont) 

No. Item Function 

5 Memory access function • Downloading to RAM 

• Downloading to flash memory 

• Single-line assembly 

• Reverse assembly (disassembly) 

• Reading of memory 

• Writing to memory 

• Automatic updating of a display of selected variables during 

user program execution 

• Fill 

• Search 

• Move 

• Copy 

6 General/control register 
access function 

Reads or writes the general/control register. 

7 Internal I/O register 
access function 

Reads or writes the internal I/O register. 

8 Source-level debugging 
function 

Various source-level debugging functions. 

9 Command line function Supports command input. 

Batch processing is enabled when a file is created by arranging 
commands in input order. 

10 Help function Describes the usage of each function or command syntax input 
from the command line window. 

 

The specific functions of the emulator are described in the next section. 
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2.2   Trace Functions 

The branch source addresses, mnemonics, operands, and source lines are displayed.  Since this 
function uses the trace buffer built into the device, a realtime trace can be acquired. 

Note: The MCUs which have no trace function cannot use this function. 

2.3   Break Functions 

The emulator has the following four break functions. 

(1) Hardware break function 

Uses a break controller incorporated in the device. 

The access address, instruction fetch address, data, or bus cycle condition can be set. 

This function can be set on the [Break Condition] page in the [Eventpoint] dialog box.  It can 
also be set from the [Event] column in the [Editor] or [Disassembly] window.  For the setting, 
refer to section 5.2.2, Viewing the Source Code. 

Note: The MCUs which have no hardware break function cannot use this function. 

(2) PC break function (BREAKPOINT) 

Breaks when the dedicated instruction at the specified address that has been replaced is 
executed. 

This function can be set on the [Breakpoint] page in the [Eventpoint] dialog box.  It can also be 
set when the [S/W breakpoint] column for the line to be set is double-clicked in the [Editor] or 
[Disassembly] window. 

(3) Forced break function 

Forcibly breaks the user program. 

(4) Address match break function 

Stops the target program immediately before a specified address instruction is executed. This 
function is featured by the address match interrupt of the MCU. This function can be set from 
the [Event] column in the [Editor] window. For the setting, refer to section 5.2.2, Viewing the 
Source Code. 

Note: The address match break points vary depending on the device. And, user program 
operation cannot be guaranteed when MCU's address match interrupts are used. 
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2.4   Memory Access Functions 

The emulator has the following memory access functions. 

(1) Memory read/write function 

[Memory] window: The memory contents are displayed in the window. Only the amount 
specified when the [Memory] window is opened can be read.  If the memory 
is written in the [Memory] window, a read in the range displayed in the 
[Memory] window will occur for updating the window.  When the [Memory] 
window is not to be updated, change the setting in [Lock Refresh] from the 
popup menu. 

me command: A command line function that reads or writes the specified amount of 
memory at the specified address. 

(2) User program downloading function 

A load module registered in the workspace can be downloaded.  Such module can be selected 
from [Download Modules] in the [Debug] menu.  Downloading is also possible by a popup menu 
that is opened by right-clicking on the mouse at the load module in the workspace.  The user 
program is downloaded to the RAM or flash memory. 

This function can download information required for source-level debugging having the 
debugging information. 

(3) Memory data uploading function 

The specified amount of memory from the specified address can be saved in an S-type-formatted 
file. 

(4) Memory data downloading function 

The memory contents saved in the S-type-formatted file can be downloaded.  Select [Load] from 
the popup menu in the [Memory] window. 

(5) Displaying the variable contents 

The variable contents specified in the user program are displayed. For the usage of the function for 
displaying the variable contents, refer to the High-performance Embedded Workshop User’s 
Manual. 
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(6) Other memory operation functions 

Other functions are as follows: 

• Memory fill 

• Memory copy 

• Memory save 

• Memory verify 

• Memory search 

• Internal I/O display 

• Displaying label and variable names and their contents 

Notes: 1. Memory access during user program execution: 
When memory is accessed from the memory window, etc. during execution of the user 
program, execution stops for the memory access and is then resumed.  Therefore, 
realtime emulation cannot be performed. 

2. Memory access during user program break: 
The program can also be downloaded and the BREAKPOINT can be set for the flash 
memory area by the emulator. 

2.5   Stack Trace Function 

The emulator uses the information on the stack to display the names of functions in the sequence 
of calls that led to the function to which the program counter is currently pointing.  This function 
can be used only when the load modules that have the following formats are loaded: 
  – H8 family C/C++ compiler (such as [R0C4008XSW06R]): ELF/Dwarf2 
  – M16C family C compiler (M3T-NC30WA): IEEE695 
  – R8C series C compiler (M3T-NC8C): IEEE695 
For the usage of this function, refer to section 6.19, Stack Trace Function. 

2.6   Online Help 

An online help explains the usage of each function or the command syntax that can be entered 
from the command line window. 

Select [Emulator Help] from the [Help] menu to view the emulator help. 
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Section 3   Preparation before Use 

3.1   Emulator Preparation 

Unpack the emulator and prepare it for use as follows: 

WARNING 
  READ the reference sections shaded in figure 3.1 before 
using the emulator product.  Incorrect operation will damage 
the user system and the emulator product. The USER 
PROGRAM will be LOST. 

Section 3

Section 4

Unpack the emulator

Check the components against the component list 
provided at the side of the component box

Start the High-performance Embedded Workshop

Turn on the user system

Component list

When the emulator
is used first.

When the emulator
is used for second
time or later.

Reference

Set up the emulator
- Install the High-performance Embedded Workshop
- Insert the emulator
- Set up the main unit of the emulator

 

Figure 3.1   Emulator Preparation Flow Chart 
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3.2   Emulator Hardware Configuration 

As shown in figure 3.2, the emulator consists of an emulator, a USB cable, and a user system 
interface cable. The emulator is connected to the host computer via USB 1.1, and also to the USB 
port conforming to USB 2.0. 

 

Figure 3.2   Emulator Hardware Configuration 
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The names of each section of the emulator are explained next. 

Emulator Upper-side Panel: 

(a)

(b)(c)

(d) (e)

 

Figure 3.3   Emulator Upper-side Panel 

(a) E7 logo plate: A green plate dedicated for the emulator is provided to be easily 
distinguished from other E-series emulators. 

(b) Sliding switch cover: A cover to protect a switch for setting the emulator, which is closed 
to prevent incorrect operation. Be sure to close this cover during 
emulation. 

(c) ACTION LED: Marked ‘ACT’. When this LED is lit, the E7 control software is in 
operation. 

(d) Host connector: Marked ‘ ’. A connector for the host computer is provided at the 
side of this mark. 

(e)    User connector: Marked ‘USER I/F’. A connector for the user system interface cable 
is provided at the side of this mark. 

Note: Even if the LED is not lit when the emulator is connected to the host computer, the USB is 
not malfunctioned. 
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Emulator Host-side Panel: 

(a)

 

Figure 3.4   Emulator Host-side Panel 

(a) Host-side connector: A USB connector for the host computer. Be sure to connect the 
provided USB cable. 

Emulator User-side Panel: 

(a)

 

Figure 3.5   Emulator User-side Panel 

(a) User-side connector: A user system interface cable is connected. 
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Emulator Bottom Panel: 

(a)

 

Figure 3.6   Emulator Bottom Panel 

(a) Seal for product management: The serial number, revision, and safety standard, etc. of the 
emulator are written to. The contents differ depending on the 
time when you purchased the product. 
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3.3   Emulator Software Configuration 

The following item is included with the emulator software when it is purchased: 
•  Tiny/Super Low Power E7 Emulator Software: HS0007TCU01SR (CD) 

3.3.1   CD 

The root directory of the CD contains a setup program for installing the emulator debugger.  The 
folders contain the files and programs listed below. 

Table 3.1   Contents of the CD Directories 

Directory Name Contents Description 

Dlls Microsoft® runtime library A runtime library for the High-performance 
Embedded Workshop.  The version is checked 
at installation and this library is copied to the 
hard disk as part of the installation process. 

Drivers E7 emulator driver The E7 emulator USB drivers. 

E7TM E7 emulator self-check 
program 

A hardware diagnostic program for the E7 
emulator. 

Help Online help for the E7 emulator An online help file. 

Manuals E7 emulator manual E7 emulator user’s manual.  This is provided 
as a PDF file. 
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3.4   Installing Emulator Debugger 

When the CD is inserted in the host computer’s CD drive, execute Setup.exe from the root 
directory of the CD. Follow the instructions of the installation wizard. 

3.5   Connecting the Emulator to the Host Computer 

This section describes how to connect the emulator to the host computer. For the position of each 
connector of the emulator, refer to section 3.2, Emulator Hardware Configuration.  

Notes: 1. When [Add New Hardware Wizard] is displayed, select the [Search for the best driver 
for your device. (Recommended)] radio button and then the [Specify a location] check 
box to select the path to be searched for drivers.  The location must be specified as 
<Drive>:\DRIVERS. (<Drive> is the CD drive name.) 

 2. Be sure to install the debugger for the emulator before putting the emulator in place. 
 

WARNING
 

  Always switch OFF the emulator product and the user 
system before connecting or disconnecting any CABLES 
except for the USB interface cable.  Failure to do so will result 
in a FIRE HAZARD and will damage the user system and the 
emulator product or will result in PERSONAL INJURY.  
The USER PROGRAM will be LOST. 
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The emulator is connected to the host computer via the USB 1.1, and also to the USB port 
conforming to USB 2.0. Figure 3.7 shows the system configuration. 

USB cable (1.5 m)

Host computer E7 emulator

 

Figure 3.7   System Configuration when Connecting the Emulator to the Host Computer 
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3.6   Connecting the Emulator to the User System 

Use the procedure below to connect the emulator to the user system with the user system interface 
cable, or to disconnect them when moving the emulator or the user system. 

1. Check that the host computer is turned off or the emulator is not connected to the host 
computer with the USB cable. 

2. Connect the user system interface cable to the user-side connector of the emulator. 

3. Connect the USB cable to the host-side connector of the emulator. 

Figure 3.8 shows the position of the connector. 

Connector for user system interface cable 

Figure 3.8   Position of the Connector 

(1) The connector must be installed to the user system.  Table 3.2 shows the recommended 
connector for the emulator.  

Table 3.2   Recommended Connector 

Type Number Manufacturer Specifications 

2514-6002 3M Limited 14-pin straight type 

 

Note: When the connector is used, do not install any components within 3 mm of the connector. 

(2) The pin assignments of the connector are shown in section 2 in the additional documents, 
Notes on Connecting the H8/xxxx, and Notes on Connecting the R8C/xxxx. 
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User system interface cable

Connector

User system

Tab

Pin 1

Pin 2

 

Figure 3.9   Connecting the User System Interface Cable to the User System 

Notes: 1. The pin number assignments of the 14-pin connector differ from those of the E10A 
emulator; however, the physical location is the same. 

 2. To connect the signals output from the connector, refer to the MCU pin alignment. 

 3. To remove the user system interface cable from the user system, pull the tab on the 
connector upward. 

 4. The range of frequencies that the emulator operates at is different according to the 
MCUs used. 

 5. Connect the signals from the connector as shown in section 2 in the additional 
documents, Notes on Connecting the H8/xxxx, and Notes on Connecting the 
R8C/xxxx. 
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3.7   Connecting System Ground 

WARNING
 

  Separate the frame ground from the signal ground at the 
user system.  Failure to do so will result in malfunction of the 
emulator. 

 
The emulator's signal ground is connected to the user system's signal ground. In the emulator, the 
signal ground and frame ground are connected. In the user system, connect the frame ground only; 
do not connect the signal ground to the frame ground (figure 3.10). 

 

Figure 3.10   Connecting System Ground 



24 

 

3.8   Setting up the E7 Emulator 

Set up the emulator’s firmware. 

Note: When the emulator is purchased, the firmware has been set up. Use the following 
procedures only when the version of the software is updated. 

CAUTION  
  Disconnect the USB cable only when an instruction is  
displayed on the screen. Incorrect operation will damage the  
emulator product. 

1. Open the sliding switch cover and check that the switch for setting the emulator is turned to 
‘1’. 

2. Select [Renesas] -> [High-performance Embedded Workshop] -> [High-performance 
Embedded Workshop] from [Programs] in the [Start] menu. 

 

Figure 3.11   Setup Tool for E7 Emulator 

Notes: 1. Setting up the emulator is not required when the versions of the emulator’s firmware 
and the setup program are the same. 

2. If other emulator than the Tiny/Super Low Power E7 is connected, the following error 
message will be displayed to exit the setup tool. 
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Figure 3.12   Error Message 

3. If the following error message is displayed, the host computer is not connected to the 
emulator or the setup switch is turned to ‘0’. 

 

 

Figure 3.13   Error Message 

If the setup switch is turned to ‘0’, set it to ‘1’ and connect the USB cable again. 
 
3. Clicking the [Setup] button displays the following dialog box. 

 

Figure 3.14   [Setup tool for E7 Emulator] Dialog Box 
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4. Turn the setup switch to ‘0’, connect the USB cable again, and click the [OK] button. Setting 
up the emulator’s firmware is started. 
When [Add New Hardware Wizard] is displayed, select the [Search for the best driver for your 
device. (Recommended)] radio button and then the [Specify a location] check box to select the 
path to be searched for drivers.   

Note: When using Windows® 2000 or Windows® XP, a dialog box will be displayed to show the 
disconnection of USB. However, this is not a problem. 

 

Figure 3.15   Start of Setting up the Emulator 

Note: Do not turn off the host computer or disconnect the USB cable during setting up the 
emulator. The emulator may be damaged. 

5. When setting up the emulator has been completed, the following message will be displayed. 
Turn the setup switch to ‘1’, connect the USB cable again, and click the [OK] button. 

 

Figure 3.16   [E7 FlashROM Setup Tool] Dialog Box 

Note: Be sure to turn the setup switch to ‘1’ except when the setup tool is used. 
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6. When the following dialog box is displayed, setting up the emulator is completed. 

 

Figure 3.17   Message for Completion of Setting up the Emulator 



28 

 

3.9   System Check 

When the software is executed, use the procedure below to check that the emulator is connected 
correctly.  Here, use the workspace for a tutorial provided on the product. 

Refer to section 4, Preparations for Debugging, for the other activating method to create a new 
project or use a workspace for the High-performance Embedded Workshop of the old version. 

1. Connect the emulator to the host computer. 

2. Connect the user system interface cable to the connector of the emulator. 

3. Connect the user system interface cable to the connector in the user system. 

4. Open the [Start] menu of Windows® and select [Renesas High-performance Embedded 
Workshop] -> [High-performance Embedded Workshop] from [Programs]. 

5. The [Welcome!] dialog box is displayed. 

 

Figure 3.18   [Welcome!] Dialog Box 

[Create a new project workspace] radio button: Creates a new workspace. 

[Open a recent project workspace] radio button: Uses the current workspace and displays 
the history of the opened workspace. 

[Browse to another project workspace] radio button: Uses the current workspace; this radio 
button is used when the history of the 
opened workspace does not remain. 
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To use a workspace for the tutorial, select the [Browse to another project workspace] radio button 
and click the [OK] button. 

When the [Open workspace] dialog box is opened, specify the following directory: 
<Windows® drive>\Workspace\Tutorial\E7\xxxx\Tutorial 

After the directory has been specified, select the following file and click the [Open] button. 

 

Figure 3.19   [Open Workspace] Dialog Box 

Note: The drive for the tutorial differs depending on the device. 
Windows® drive for the R8C/Tiny:  
  \Workspace\Tutorial\E7\R8C\Tutorial 
Windows® drive for the H8/Tiny normal mode:  
  \Workspace\Tutorial\E7\H8\Tutorial 
Windows® drive for the H8/Tiny advanced mode:  
  \Workspace\Tutorial\E7\H8\TutorialADV 
Windows® drive for the H8/Super Low Power:  
  \Workspace\Tutorial\E7\H8\TutorialSLP 



30 

 

6. The [Select Emulator mode] dialog box is displayed. 

 

Figure 3.20   [Select Emulator mode] Dialog Box 

Select the device name in use from the [Device] drop-down list box. The following items are 
selected in the [Mode] group box. 

⎯ Download emulator firmware 

This mode is used when there is no emulator program in the flash memory of the target 
device. Select this mode when the version of the emulator’s software is updated or the ID 
code is changed. 

Note: The emulator occupies the user’s flash memory area according to the target devices. For 
details, refer to the additional documents, Notes on Connecting the H8/xxxx, and Notes on 
Connecting the R8C/xxxx. 

⎯ Does not download emulator firmware 

This mode is used when there is a program for the emulator in the flash memory of the 
target device. When the emulator is activated, the flash memory is not reprogrammed. 
However, be sure to enter the ID code specified above. If an incorrect code is entered, all 
the programs on the flash memory will be erased. 

⎯ Writing Flash memory 

This mode is used when the emulator is used for programming the flash memory. 
Debugging the program is disabled. To download the load module, register it in the 
workspace. 
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7. The [Connecting] dialog box is displayed and the emulator connection is started. 

 

Figure 3.21   [Connecting] Dialog Box 

8. The dialog box is displayed as shown in figure 3.22. 

 

Figure 3.22   Dialog Box of the Power-on Request Message 

9. Power on the user system. 
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10. When using the H8 family microcomputer, the dialog box shown in figure 3.23 is open. Input 
the system clock value. When using the R8C/Tiny series MCU, the dialog box shown in figure 
3.24 is open. Select the communication clock value. Using the default value is recommended. 

 

Figure 3.23   [System Clock] Dialog Box 

 

Figure 3.24   [Communication Clock] Dialog Box 
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11. After the following dialog box is displayed, input the ID code. When the emulator is activated 
in the [Download emulator firmware] mode, input any hexadecimal four-digit ID code to be 
set (except for H’FFFF). When the emulator is activated in the [Does not download emulator 
firmware] mode, input the correct ID code. If an incorrect ID code is input, all the contents of 
the flash memory will be erased. In this case, restart the emulator in the [Download emulator 
firmware] mode. 

 

Figure 3.25   [ID Code] Dialog Box 

Note: If using the R8C/Tiny series MCU, the ID code is set at build. When the High-
performance Embedded Workshop starts in Download emulator firmware mode, the [ID 
Code] dialog box does not open. 



34 

 

12. When "Connected" is displayed in the [Output] window of the High-performance Embedded 
Workshop, the emulator initiation is completed. 

 

Figure 3.26   High-performance Embedded Workshop Window 

Note:  When the user program has already been downloaded to the flash memory, source-level 
debugging cannot be executed because there is no debugging information on the user 
program after the emulator has been activated. Be sure to load the debugging information 
file. For details, refer to section 4.3.1, Setting at Emulator Activation. 
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Notes:  1. If the user system interface cable is disconnected from the connector on the user 
system, the following dialog box will appear. 
 

 

Figure 3.27   [Connector disconnected] Dialog Box 

 2. If the emulator is not properly initialized, one of the dialog boxes shown in figures 3.28 
through 3.31 will appear. 

(a) The following dialog box is displayed when the flash memory cannot be erased.  
Exchange the MCU since the flash memory has been programmed more times than 
the limitation. 
 

 

Figure 3.28   [Flash memory erase error!] Dialog Box 
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(b) The following dialog box is displayed when the flash memory cannot be programmed.  
An incorrect system clock value has been input or the flash memory has been 
programmed more times than the limitation. 
 

 

Figure 3.29   [Error sending Flash memory write program] Dialog Box 

(c) The following dialog box is displayed when an incorrect ID code has been input.  For 
security, the flash memory is completely erased. 
 

 

Figure 3.30   [ID code error!] Dialog Box 

(d) The following dialog box is displayed when the MCU cannot communicate with the 
emulator.  Check the MCU settings. 
 

 

Figure 3.31   [Boot Failed!] Dialog Box 
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 3. If an incorrect driver has been selected, the following dialog box will appear. 
 

 

Figure 3.32   [Unable to restore the previous driver settings] Dialog Box 
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3.10   Uninstalling the Emulator’s Software 

Follow this procedure to remove the installed emulator’s software from the user’s host computer.  
As the installed product is known by the High-performance Embedded Workshop, uninstall the 
product on the High-performance Embedded Workshop screen. 

1. Activate the High-performance Embedded Workshop. 

2. Click the [Administration…] button in the [Welcome!] dialog box. 
 

 

Figure 3.33   [Welcome!] Dialog Box 
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3. The [Tools Administration] dialog box is opened. 
 

 

Figure 3.34   [Tools Administration] Dialog Box 
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4. Click the [+] mark at the left of [Debugger Components] in the [Registered components] list 
box to list the installed components.  Then, highlight the product name to be uninstalled. 

 

 

Figure 3.35   Highlighting the Product to be Uninstalled 

5. Click the [Unregister] button.  After the following message box is displayed, click the [Yes] 
button. 

 

 

Figure 3.36   [Unregistering this tool] Message Box 

This is the end of canceling the High-performance Embedded Workshop registration.  Then, 
remove the file for the emulator from the host computer. 

 



41 

 

6. Click the [Uninstaller…] button in the [Tools Administration] dialog box to open the 
[Uninstall HEW Tool] dialog box. 

 

 

Figure 3.37   [Uninstall HEW Tool] Dialog Box 
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7. Click the [Start] button to list the installed components. 
 

 

Figure 3.38   Highlighting the Product to be Uninstalled 

Highlight the product name to be uninstalled and click the [Uninstall] button.  This is the end 
of uninstallation. 

CAUTION  
  A shared file may be detected while the program is being 
removed.  If another product may be using the shared file, do 
not remove the file.  If another product does not start up after 
the removal process, re-install that product. 
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Section 4   Preparations for Debugging 

4.1 Method for Activating High-performance Embedded Workshop 

To activate the High-performance Embedded Workshop, follow the procedure listed below. 

1. Connect the emulator to the host computer and the user system, then turn on the user system. 

2. Turn on the emulator. Be sure to turn on the user system before supplying power to the 
emulator if you use the user system. 

3. Open the [Start] menu of Windows® and select [High-performance Embedded Workshop] 
from [Renesas High-performance Embedded Workshop] of [Programs]. 

4.   The [Welcome!] dialog box is displayed. 

 

Figure 4.1   [Welcome!] Dialog Box 

[Create a new project workspace] radio button: Creates a new workspace. 

[Open a recent project workspace] radio button: Uses the current workspace and displays 
the history of the opened workspace. 

[Browse to another project workspace] radio button: Uses the current workspace; this radio 
button is used when the history of the 
opened workspace does not remain. 

In this section, we describe the following three ways to start up the High-performance Embedded 
Workshop: 
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• [Create a new project workspace] - a toolchain is not in use 

• [Create a new project workspace] - a toolchain is in use 

• [Browse to another project workspace] 

 
The [Open a recent project workspace] radio button is used to omit the operation for specifying the 
workspace file when [Browse to another project workspace] is selected. 

4.1.1 Creating the New Workspace (Toolchain Not Used) 

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded 
Workshop is activated, select [Create a new project workspace] radio button and click the 
[OK] button. 

 

 

Figure 4.2   [Welcome!] Dialog Box 



45 

 

2. The Project Generator is started.  This section omits the description on the setting for the 
toolchain. 
If you have not purchased the toolchain, the following dialog box is displayed. 

 

 

Figure 4.3   [New Project Workspace] Dialog Box 

[Workspace Name] edit box: Enter the new workspace name.  Here, enter ‘test’. 

[Project Name] edit box: Enter the project name.  When the project name is the same as 
the workspace name, it needs not be entered. 

Other list boxes are used for setting the toolchain; the fixed information is displayed when the 
toolchain has not been installed. 
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3. The following dialog box is displayed. 
 

 

Figure 4.4   [Setting the Target System for Debugging] Dialog Box 

Check [Tiny/SLP E7 SYSTEM] and click the [Next] button. 
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4. Set the configuration file name.  The configuration file saves the state of High-performance 
Embedded Workshop except for the emulator. 

 

 

Figure 4.5   [Setting the Debugger Options] Dialog Box 

This is the end of the emulator setting. 

Click the [Finish] button to exit the Project Generator.  The High-performance Embedded 
Workshop is activated. 

5. After the High-performance Embedded Workshop has been activated, the emulator is 
automatically connected.  For operation during connection, refer to section 3.9, System Check. 
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4.1.2 Creating the New Workspace (Toolchain Used) 

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded 
Workshop is activated, select [Create a new project workspace] radio button and click the 
[OK] button. 

 

 

Figure 4.6   [Welcome!] Dialog Box 
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2. The Project Generator is started. 
If the toolchain has been installed, the following dialog box is displayed. 

 

 

Figure 4.7   [New Project Workspace] Dialog Box 

[Workspace Name] edit box: Enter the new workspace name.  Here, enter ‘test’. 

[Project Name] edit box: Enter the project name.  When the project name is the 
same as the workspace name, it needs not be entered. 

[CPU family] drop-down list box: Select the target CPU family. 

[Tool chain] drop-down list box: Select the target toolchain name when using the toolchain.  
Otherwise, select [None]. 

[Project type] list box: Select the project type to be used. 
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3. Make the required setting for the toolchain. 
 

 

Figure 4.8   [New Project – 7/9 – Setting the Target System for Debugging] Dialog Box 

Select the CPU series and CPU type to be used, and click the [Next] button. 
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4. Set the configuration file name.  The configuration file saves the state of High-performance 
Embedded Workshop except for the emulator. 

 

 

Figure 4.9   [New Project – 8/9 – Setting the Debugger Options] Dialog Box 

This is the end of the emulator setting. 

Exit the Project Generator depending on the instructions on the screen.  The High-performance 
Embedded Workshop is activated. 

5. After the High-performance Embedded Workshop has been activated, connect the emulator.  
However, it is not needed to connect the emulator immediately after the High-performance 
Embedded Workshop has been activated. 
To connect the emulator, use one of the methods (a) and (b) below.  For operation during 
connection, refer to section 3.9, System Check. 
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(a) Connecting the emulator after the setting at emulator activation 

Select [Debug settings] from the [Options] menu to open the [Debug Settings] dialog box.  It is 
possible to register the download module or the command chain that is automatically executed 
at activation.  For details on the [Debug Settings] dialog box, refer to section 4.2, Setting at 
Emulator Activation. 

After the [Debug Settings] dialog box has been set, when the dialog box is closed, the emulator 
is connected. 

 
(b) Connecting the emulator without the setting at emulator activation 

The emulator can be easily connected by switching the session file that the setting for the 
emulator use has been registered. 

 

 

Figure 4.10   Selecting the Session File 

In the list box that is circled in figure 4.10, select the session file name including the character 
string that has been set in the [Target name] text box in figure 4.9, [New Project – 8/9 – Setting 
the Debugger Options] dialog box.  The setting for using the emulator has been registered in this 
session file. 

After selected, the emulator is automatically connected. 
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4.1.3 Selecting an Existing Workspace 

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded 
Workshop is activated, select [Browse to another project workspace] radio button and click the 
[OK] button. 

 

 

Figure 4.11   [Welcome!] Dialog Box 
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2. The [Open Workspace] dialog box is displayed. Select a directory in which you have created a 
workspace. 
After that, select the workspace file (.hws) and press the [Open] button. 

 

 

Figure 4.12   [Open Workspace] Dialog Box 

3. This activates the High-performance Embedded Workshop and recovers the state of the 
selected workspace at the time it was saved. 
When the saved state information of the selected workspace includes connection to the 
emulator, the emulator will automatically be connected. To connect the emulator when the 
saved state information does not include connection to the emulator, refer to item 5 of section 
4.1.2, Creating the New Workspace (Toolchain Used). 
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4.2 Setting at Emulator Activation 

4.2.1 Setting at Emulator Activation 

When the emulator is activated, the command chain can be automatically executed.  It is also 
possible to register multiple load modules to be downloaded.  The registered load modules are 
displayed on the workspace window. 

1. Select [Debug Settings…] from the [Debug] menu to open the [Debug Settings] dialog box. 
 

 

Figure 4.13   [Debug Settings] Dialog Box ([Target] Page) 

2. Select the product name to be connected in the [Target] drop-down list box. 

3. Select the format of the load module to be downloaded in the [Default Debug Format] drop-
down list box, then register the corresponding download module in the [Download Modules] 
list box. 

4. Click the [Options] tab. 
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Figure 4.14   [Debug Settings] Dialog Box ([Options] Page) 

The command chain that is automatically executed at the specified timing is registered.  The 
following three timings can be specified: 

• At connecting the emulator 

• Immediately before downloading 

• Immediately after downloading 

Specify the timing for executing the command chain in the [Command batch file load timing] 
drop-down list box.  In addition, register the command-chain file that is executed at the specified 
timing in the [Command Line Batch Processing] list box. 
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4.2.2 Downloading a Program 

A download module is added under [Download modules] in the [Workspace] window. 

Open the load module of [Download modules] in the [Workspace] window by clicking the right-
hand mouse button and select [Download module] to start downloading the module. 

 

Figure 4.15   Download Menu of the [Workspace] Window ([Project Files]) 

Notes: 1. When load modules are downloaded, select [Debug] -> [Download] -> [All DownLoad 
Modules]. 

 2. The emulator downloads programs to the flash memory just before execution of the 
user program (for H8 Tiny/Super Low Power series only). 
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4.2.3 Setting the Writing Flash Memory Mode 

The following describes the procedures when the emulator is used as the programming tool. The 
load module to be downloaded to the new workspace is registered and programmed. 

(a) Select the new project workspace. 
 

 

Figure 4.16   [New Project Workspace] Dialog Box 
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(b) Select the target MCU and click the [Next] button. 
 

 

Figure 4.17   [Setting the Target System for Debugging] Dialog Box 
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(c) Select the configuration file name and click the [Finish] button. 
 

 

Figure 4.18   [Setting the Debugger Options] Dialog Box 
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(d) The [Select Emulator mode] dialog box is displayed. 
 

 

Figure 4.19   [Select Emulator mode] Dialog Box 

Select the [Writing Flash memory] mode. 

 

(e) Turn on the target board and press the [OK] button. 
 

 

Figure 4.20   Dialog Box of the Power-on Request Message 
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(f) Input the system clock value. 
 

 

Figure 4.21   [System Clock] Dialog Box 

(g) Select [Debug Setting] from the [Option] menu. 
 

 

Figure 4.22   High-performance Embedded Workshop Window 
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(h) Select the target MCU and then the download module with the [Add…] button. 
 

 

Figure 4.23   [Debug Settings] Dialog Box ([Target] Page) 
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(i) The download file is displayed on [Project Files]. 
 

 

Figure 4.24   [Workspace] Window ([Project Files]) 
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(j) Select and download the file with the right-hand mouse button. 
 

 

Figure 4.25   Download Menu of the [Workspace] Window ([Project Files]) 
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(k) The dialog box for sum checking is displayed and programming is completed. Sum data is 
a value that data in the internal ROM area has been added by byte. 
 

 

Figure 4.26   Message for Completion of Flash Memory Programming 

(k) When the following dialog box is displayed, close and restart or exit the workspace. 
To write the same data to the MCU continuously, select [Debug -> Initialize…] and go 
back to step (c) (displaying [Select Emulator mode]). To exit, close the workspace. 
 

 

Figure 4.27   Message for Restarting or Exiting Writing Flash Memory Mode 
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Section 5   Debugging 

This section describes the debugging operations and their related windows and dialog boxes. 

For the debugging functions that are common for the High-performance Embedded Workshop 
products, refer to the High-performance Embedded Workshop User’s Manual. 

5.1 Setting the Environment for Emulation 

5.1.1 Opening the [Configuration] Dialog Box 

Selecting [Options -> Emulator -> System…] or clicking the [Emulator System] toolbar button 

( ) opens the [Configuration] dialog box. 
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5.1.2 [General] Page 

Sets the emulator operation conditions. 

 

Figure 5.1   [Configuration] Dialog Box ([General] Page) 
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Items that can be displayed in this dialog box are listed below. 

[Device] combo box Displays the MCU name. 
  
[Emulation mode] combo box Selects the emulation mode at user program execution. 

Select Normal to perform normal emulation. 

Select No break to disable PC breakpoint or break condition 
settings during emulation. 

  
[Step option] combo box Sets the step interrupt option. 

Disable interrupts during single step execution: Disables 
interrupts*1 during step execution. 

Enable interrupts during single step execution: Enables 
interrupts*1 during step execution. 

  
[NMI signal] group box Sets the use of the NMI signal. 

When used as a forced break in the emulator, select Emulator. 
In this case, the NMI signal cannot be used. The contents of 
the NMI vector address are rewritten by the emulator program. 
When used in the user program, select User. In this case, the 
forced break cannot be used. Before user program execution, 
set the breakpoints or break conditions for the exception 
processing and generate exceptions to halt the program. 

[User interface clock] combo box Displays the transfer clock of the user interface. 
  
[Breakcondition mode]  
group box 

Sets the address break release function. 

When the address break function is not used in the user 
program, select Emulator. In this case, the hardware break and 
step functions can be used. The contents of the vector address 
are rewritten by the emulator program to satisfy the break 
conditions. 

When the address break is used in the user program, select 
User. In this case, the hardware break and step functions 
cannot be used. 

  
[Flash memory synchronization] 
combo box 

Selects whether or not the contents of the flash memory are 
acquired by the emulator when the user program is stopped or 
the position where the PC break is set is put back as the 
original code. 

When the flash memory is not programmed by the user 
program, its contents need not be acquired by the emulator. 
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 If there is no problem with the state that the program in the 
flash memory has been replaced as the PC break code, the 
position where the PC break is set needs not be put back as the 
original code. 

Disable:  Read or program is not performed for the flash 
memory except when the emulator is activated, the 
flash memory area is modified, and the settings of 
the PC break to the flash memory area are changed. 

PC to flash memory:  When the user program is stopped, the 
specified PC break code is replaced as 
the original instruction. Select this 
option if there is a problem with the state 
that the program in the flash memory 
has been replaced as the PC break code. 

Flash memory to PC: When the user program is stopped, the 
contents of the flash memory are read by 
the emulator. Select this option if the 
flash memory is reprogrammed by the 
user program. 

PC to flash memory, Flash memory to PC:  
When the user program is stopped, the contents of the 
flash memory are read by the emulator and the specified 
PC break code is replaced as the original instruction. 
Select this option if the flash memory is reprogrammed 
by the user program and there is a problem with the state 
that the program in the flash memory has been replaced 
as the PC break code. 

[Step Over option] combo box Enables or disables programming of the flash memory while 
executing step operation. 

Programming of the flash memory: Uses a software break for 
step operation (e.g. Step Over) and enables programming of 
the flash memory. 

No Programming of the flash memory: Uses Break Condition 
for step operation (e.g. Step Over) and disables programming 
of the flash memory*2. 

[Flash memory write after 
download] group box 

Enables or disables programming of the flash memory after 
downloading the program. 

Disable: Disables programming of the flash memory after 
downloading the program. 

Enable: Enables programming of the flash memory after 
downloading the program. 
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Notes: 1. Includes interrupts in a break. 

 2. When Step Over is performed after selecting [No Programming of the flash memory] 
for [Step Over option], the instruction that follows a JSR, BSR, or TRAPA instruction 
will also be executed. If there are consecutive JSR, BSR, or TRAPA instructions, 
execution proceeds until it reaches an instruction that is not JSR, BSR, or TRAPA. 
(When there are consecutive function calls in C language, the program steps all of 
these functions.) 
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5.2 Downloading a Program 

This section describes how to download a program and view it as source code or assembly-
language mnemonics. 

Note: When a break occurs, the High-performance Embedded Workshop displays the location of 
the program counter (PC). In most cases, for example if an Elf/Dwarf2-based project is 
moved from its original path (at the build), the source file may not be automatically found.  
In this case, the High-performance Embedded Workshop will open a source file browser 
dialog box to allow you to manually locate the file. 

5.2.1 Downloading a Program 

A load module to be debugged must be downloaded. 

To download a program, select the load module from [Debug -> Download] or select [Download] 
from the popup menu opened by clicking the right-hand mouse button on the load module in 
[Download modules] of the [Workspace] window. 

Note: Before downloading a program, it must be registered to the High-performance Embedded 
Workshop as a load module. For registration, refer to section 4.2, Setting at Emulator 
Activation. 
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5.2.2 Viewing the Source Code 

Select a source file name in the [Workspace] window and click [Open] in the popup menu to make 
the High-performance Embedded Workshop display the source file in the editor.  It is also possible 
to display your source files by double-clicking on their names in the [Workspace] window. 

 

Figure 5.2   [Editor] Window 
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In this window, the following items are shown on the left as line information. 

 The first column (Line number column): Line number 

 The second column (Source address column): Address information 

 The third column (Event column): Event information (break condition) 

 The fourth column (Editor column): PC, bookmark, and breakpoint information 

The right window that shows the source is called as the [Editor] window. 

Source address column 

When a program is downloaded, an address for the current source file is displayed on the Source 
address column. These addresses are helpful when setting the PC value or a breakpoint. 

Event column 

The Event column displays the following item: 

: An address condition as a break condition is set. 

: An address interrupt break is set. 

This is also set by using the popup menu.  

The bitmap symbol above is shown by double-clicking the Event column. This is also set by using 
the popup menu. 

 

Figure 5.3   Popup Menu 

Notes: 1. The contents of the Event column are erased when conditions other than the address 
condition are added to each channel by using the [Edit] menu or in the [Event] window. 

 2. The conditions for setting the break condition differ depending on the device. For 
details, refer to the online help. 
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Editor column 

Editor column displays the following items: 

: A bookmark is set. 

: A PC Break is set. 

: PC location 

 
 To switch off a column in all source files 

1. Click the right-hand mouse button on the [Editor] window or select the [Edit] menu.  

2. Click the [Define Column Format…] menu item. 

3. The [Global Editor Column States] dialog box is displayed. 

4. A check box indicates whether the column is enabled or not.  If it is checked, the column is 
enabled. If the check box is gray, the column is enabled in some files and disabled in 
others. 

5. Click the [OK] button for the new column settings to take effect. 
 

 

Figure 5.4   [Global Editor Column States] Dialog Box 

 To switch off a column in one source file 

1. Open the source file which contains the column you want to remove and click the [Edit] 
menu. 

2. Click the [Columns] menu item to display a cascaded menu item.  The columns are 
displayed in this popup menu.  If a column is enabled, it has a tick mark next to its name.  
Clicking the entry will toggle whether the column is displayed or not. 
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5.3 Stopping Your Program 

This section describes how you can halt execution of your application's code. This section 
describes how to do this directly by using the [Halt] button and by setting breakpoints at specific 
locations in your code. 

5.3.1 Address Match Breakpoints 

When you are trying to debug your program you will want to be able to stop the program running when 
it reaches a specific point or points in your code. You can do this by setting the address match 
breakpoint on the line or instruction at which you want the execution to stop. The following instructions 
will show you how to quickly set and clear address match breakpoint. 

When you are trying to debug your program you will want to be able to stop the program running 
when it reaches a specific point or points in your code. You can do this by setting an address 
match breakpoint on the line or instruction at which you want the execution to stop. The following 
instructions will show you how to quickly set and clear address match breakpoints. 

• To set an address match breakpoint in the [Editor] window 

1. Make sure that the [Disassembly] or [Editor] window is open at the place you want to set 
an address match breakpoint. 

2. Double-click in the [Event] column at the line which you want the program to stop. 

3. You will see a blue circle appear in the [Event] column to indicate that an address match 
breakpoint has been set. 

 
Now when you run your program and it reaches the address at which you set the address match 
breakpoint, execution halts with the message "BREAK CONDITION" displayed in the [Debug] 
sheet of the [Output] window, and the [Editor] or [Disassembly] window is updated with the 
address match breakpoint line marked with an arrow in the gutter. 

Note: When a break occurs, the program stops just before it is about to execute the line or 
instruction at which you set an address match breakpoint. If you choose Go or Step after 
stopping at the address match breakpoint, then the line marked with an arrow will be the 
next instruction to be executed. 

About address match breakpoints, see also section 5.4.13, Setting Break Conditions. 
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5.4 Using the Event Points 

The emulator has the event point function that performs breaking, tracing, and measuring the 
execution time by specifying higher-level conditions along with the PC breakpoints standard for 
the High-performance Embedded Workshop. 

5.4.1 PC Breakpoints 

When the instruction of the specified address is fetched, the user program is stopped. Up to 255 
points can be set. 

5.4.2 Break Conditions 

Break conditions can be used for higher-level conditions such as the data condition as well as 
specification of the single address.  

5.4.3 Opening the [Event] Window 

Select [View -> Code -> Eventpoints] or click the [Eventpoints] toolbar button ( ) to open the 
[Event] window. 

The [Event] window has the following two sheets: 

[Breakpoint] sheet: Displays the settings made for PC breakpoints. It is also possible to set, 
modify, and cancel PC breakpoints. 

[Breakcondition] sheet:  Displays or sets the settings made for break condition channels.  
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5.4.4 Setting PC Breakpoints 

It is possible to display, modify, and add PC breakpoints on the [Breakpoint] sheet. 

 

Figure 5.5   [Event] Window ([Breakpoint] Sheet) 

This window displays and sets the breakpoints. Items that can be displayed in the sheet are listed 
below. 

[Type] Breakpoint 

[State] Whether the breakpoint is enabled or disabled 

 [Condition] An address that the breakpoint is set 
 Address = Program counter (Corresponding file name, line, and symbol name) 

[Action] Operation of the emulator when a break condition is satisfied 
 Break: Halts execution 

When a breakpoint is double-clicked in this window, the [Set Break] dialog box is opened and 
break conditions can be modified. 

A popup menu containing the following options is available by right-clicking within the window. 

5.4.5 Add 

Sets breakpoints. Clicking this item will open the [Set Break] dialog box and break conditions can 
be specified. 
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5.4.6 Edit 

Only enabled when one breakpoint is selected. Select a breakpoint to be edited and click this item. 
The [Set Break] dialog box will open and break conditions can be changed.  

5.4.7 Enable 

Enables the selected breakpoint(s). 

5.4.8 Disable 

Disables the selected breakpoint(s). When a breakpoint is disabled, the breakpoint will remain in 
the list; when specified conditions have been satisfied, a break will not occur. 

5.4.9 Delete 

Removes the selected breakpoint. To retain the details of the breakpoint but not have it cause a 
break when its conditions are met, use the Disable option (see section 5.4.8, Disable). 

5.4.10 Delete All 

Removes all breakpoints. 

5.4.11 Go to Source 

Only enabled when one breakpoint is selected. Opens the [Editor] window at the address of the 
breakpoint. 
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5.4.12 [Set Break] Dialog Box 

 

Figure 5.6   [Set Break] Dialog Box 

This dialog box specifies break conditions.  

A breakpoint address to be set is specified in the [Address] edit box. Up to 255 breakpoints can be 
specified. 

When [Address] is selected, if an overloaded function or class name including a member function 
is specified in address, the [Select Function] dialog box opens. 

Clicking the [OK] button sets the break conditions. Clicking the [Cancel] button closes this dialog 
box without setting the break conditions. 
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Notes on Setting the [Set Break] Dialog Box 

1. When an odd address is set, the address is rounded down to an even address.   

2. A software break is accomplished by replacing instructions.  Accordingly, it can be set only to 
the flash memory or RAM area.  However, a software break cannot be set to the following 
addresses: 

⎯ An area other than the flash memory or RAM 

⎯ An area occupied by the E7 emulator program 

⎯ An instruction in which Break Condition 1 is satisfied 

3. During step execution, a software breakpoint is disabled. 

4. A condition set at Break Condition 1 is disabled immediately after starting execution when an 
instruction at a software breakpoint is executed.  A break does not occur even if a condition of 
Break Condition 1 is satisfied immediately after starting the execution. 

5. When execution resumes from the breakpoint address after the program execution stops at the 
software breakpoint, single-step execution is performed at the address before execution 
resumes.  Therefore, realtime operation cannot be performed.   

6. Settings of software breakpoint and Break Condition 1 are invalid while the STEP OVER 
function is being used. 

5.4.13 Setting Break Conditions 

On the [Breakcondition] sheet, the settings for break conditions are displayed, modified, and 
added. For R8C/Tiny series, on the [Breakcondition] sheet, the settings for address interrupt 
breakpoint are displayed, modified, and added. 

 

Figure 5.7   [Event] Window ([Breakcondition] Sheet) 
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Note: The items that can be set in this window differ depending on the product. For the settings 
for each product, refer to the online help. 

This window displays and sets the break condition. 

Notes on Setting the Break Condition: 

1. When [Step In], [Step Over], or [Step Out] is selected, the settings of Break Condition 1 are 
disabled.   

2. Setting of Break Condition 1 is disabled when an instruction to which a BREAKPOINT has 
been set is executed.  

3. When step over function is used, the settings of BREAKPOINT and Break Condition 1 are 
disabled. 

Notes on Setting the Break Condition (for R8C/Tiny Series): 

1. When [Go to cursor], [Step In], [Step Over], or [Step Out] is selected, the settings of Break 
Condition are disabled. 

2. Setting of Break Condition is disabled when an instruction to which a BREAKPOINT has been 
set is executed. 

3. Setting of BREAKPOINT is disabled when BREAKPOINT and Break Condition are set at 
same address. 

4. When step over function is used, the settings of BREAKPOINT and Break Condition are 
disabled. 

Items that can be displayed in the sheet are listed below. 

[Type] Break channel number 

[State] Whether the breakpoint is enabled or disabled 

[Condition] A condition that satisfies a break 

[Action] Operation of the emulator when a break condition is satisfied 
 Break: Halts execution 

When a breakpoint is double-clicked in this window, the [Break condition 1] dialog box is 
opened and break conditions can be modified. For details on the [Break condition 1] dialog box, 
refer to the online help for each product. 

A popup menu containing the following options is available by right-clicking within the window. 
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5.4.14 Edit... 

Only enabled when one breakpoint is selected. Select a breakpoint to be edited and click this item. 
The [Break condition 1] dialog box will open and break conditions can be changed.  

5.4.15 Enable 

Enables the selected break channel(s). A break channel that the condition has not been set is not 
enabled. 

5.4.16 Disable 

Disables the selected break channel(s). When a break channel is disabled, a break will not occur 
even if specified conditions have been satisfied. 

5.4.17 Delete 

Initializes the condition of the selected break channel. To retain the details of the break channel 
but not have it cause a break when its conditions are met, use the Disable option (see section 
5.4.16, Disable). 

5.4.18 Delete All 

Initializes conditions of all break channels. 

5.4.19 Go to Source 

Only enabled when one break channel is selected. Opens the [Editor] window at address of break 
channel. 

If an address value has not been set to the break channel, this option cannot be used. 

5.4.20 Editing Break Conditions 

Handlings for settings other than PC breakpoints and break conditions are common. The following 
describes examples of such handling. 
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5.4.21 Modifying Break Conditions 

Select a break condition to be modified, and choose [Edit...] from the popup menu to open the 
dialog box for the event, which allows the user to modify the break conditions. The [Edit...] menu 
is only available when one break condition is selected.  

5.4.22 Enabling Break Conditions 

Select a break condition and choose [Enable] from the popup menu to enable the selected break 
condition. 

5.4.23 Disabling Break Conditions 

Select a break condition and choose [Disable] from the popup menu to disable the selected break 
condition. When a break condition is disabled, the break condition will remain in the list, but an 
event will not occur when the specified conditions have been satisfied. 

5.4.24 Deleting Break Conditions 

Select a break condition and choose [Delete] from the popup menu to remove the selected break 
condition. To retain the break condition but not have it cause an event when its conditions are met, 
use the [Disable] option (see section 5.4.23, Disabling Break Conditions). 

5.4.25 Deleting All Break Conditions 

Choose [Delete All] from the popup menu to remove all break conditions. 

5.4.26 Viewing the Source Line for Break Conditions 

Select a break condition and choose [Go to Source] from the popup menu to open the [Editor] or 
[Disassembly] window at the address of the break condition. The [Go to Source] menu is only 
available when one break condition that has the corresponding source file is selected.  
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5.4.27 [Break condition x] Dialog Box 

 

Figure 5.8   [Break condition 1] Dialog Box 

This page sets the address bus, data bus, and read/write cycle conditions. For R8C/Tiny series, 
only address can be specified. 

Note: The items that can be set in this dialog box differ depending on the product. For the 
settings for each product, refer to the online help. 
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The [Address] group box sets address bus conditions. 

Option Description 

[Don’t care] check box Does not set address conditions. 

[Address] radio button Sets the use of the normal address bus as break 
conditions. 

[Only program fetched address after] 
radio button  

Sets a break after prefetched address execution as break 
conditions. 

[Address] edit box Sets the address bus value with a number or a symbol. 

[Mask] edit box Sets a value to be masked when [User mask] is selected.  
For masked bits, the break condition is satisfied for any 
values. 

 

The contents of an option that can be will change depending on the radio button selected. 

Option Description 

[Address] radio button All options can be set. 

[Only program fetched address after] 
radio button  

The [Address] option can be set. 

 

The [Data] group box sets the data bus conditions. 

Option Description 

[Don’t care] check box No data conditions are set. 

[Value] edit box Sets the data bus with a number. 

[Low byte] radio button Sets data access size as the lower 8-bit access. 

[High byte] radio button Sets data access size as the upper 8-bit access. 

[Word] radio button Sets data access size as the word access. 

 

The [Read/Write] group box sets the read/write cycle conditions. 

Option Description 

[Read/Write] radio button Sets the read/write cycle conditions as break conditions. 

[Read] radio button Sets read cycles as break conditions. 

[Write] radio button Sets write cycles as break conditions. 
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5.5 Viewing the Trace Information 

For the description on the trace function, refer to section 2.2, Trace Functions. 

5.5.1 Opening the [Trace] Window 

To open the [Trace] window, choose [View -> Code -> Trace] or click the [Trace] toolbar button 
( ). 

5.5.2 Acquiring Trace Information 

The acquired trace information is displayed in the [Trace] window. 

 

Figure 5.9   [Trace] Window 

This window displays the following trace information items: 

[PTR] Pointer to a location in the trace buffer (+0 for the last executed instruction) 

[IP] The amount of acquired trace information 

[Type] Type of branch:  
 BRANCH: branch source 

[Address] Instruction address 

[Instruction] Instruction mnemonic 

[Source] The C/C++ or assembly-language source program 

[Label] Label information 
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It is possible to hide any column not necessary in the [Trace] window. Selecting a column you 
want to hide from the popup menu displayed by clicking the right-hand mouse button on the 
header column hides that column. To display the hidden column, select the column from the said 
popup menu again. 

Note: The number of branch instructions that can be acquired by a trace and the trace display 
differ depending on the product.  For the specification of each product, refer to the online 
help. 

5.5.3 Clearing the Trace Information 

When [Clear] is selected from the popup menu, the trace buffer that stores the trace information 
becomes empty. If several [Trace] windows are open, all [Trace] windows will be cleared as they 
all access the same buffer. 

5.5.4 Saving the Trace Information in a File 

Select [Save...] from the popup menu to open the [Save As] file dialog box, which allows the user 
to save the information displayed in the [Trace] window as a text file. A range can be specified 
based on the [PTR] number. This file can only be saved; it cannot be reloaded into the [Trace] 
window. 

5.5.5 Viewing the [Editor] Window 

The [Editor] window corresponding to the selected trace record can be displayed in the following 
two ways: 

• Select a trace record and choose [View Source] from the popup menu. 

• Double-click a trace record 
 
The [Editor] or [Disassembly] window opens and the selected line is marked with a cursor. 

5.5.6 Trimming the Source 

Choose [Trim Source] from the popup menu to remove the white space from the left side of the 
source. 

When the white space is removed, a check mark is shown to the left of the [Trim Source] menu. 
To restore the white space, choose [Trim Source] while the check mark is shown. 
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Section 6   Tutorial 

6.1   Introduction 

This section describes the main functions of the emulator by using a tutorial program. 

The tutorial program is based on the C++ program that sorts ten random data items in ascending or 
descending order.  The tutorial program performs the following actions: 

• The main function generates random data to be sorted. 

• The sort function sorts the generated random data in ascending order. 

• The change function then sorts the data in descending order. 

 
The file tutorial.cpp contains source code for the tutorial program.  The file 
Tutorial.abs is a compiled load module in the Elf/Dwarf2 format. 

Note: After recompilation, the addresses may differ from those given in this section. 

6.2   Running the High-performance Embedded Workshop 

To run the High-performance Embedded Workshop, refer to section 3.9, System Check. 

6.3   Setting up the Emulator 

This section describes the basic settings of the emulator. 
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6.4   Setting the [Configuration] Dialog Box 

• Select [Emulator] then [Systems…] from the [Options] menu for the basic settings of the 
emulator.  The [Configuration] dialog box is displayed. 

 

 

Figure 6.1   [Configuration] Dialog Box 

Note: The items that can be set in this dialog box differ depending on the product. For the 
settings for each product, refer to the online help. 
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Table 6.1   [General] Page Options 

Option Value 

Device Selects the MCU name. 

Emulation mode Normal (normal execution, default) 

Step option Disables interrupts during single step 
execution (default) 

NMI signal Emulator (default) 

User interface clock According to the system clock frequency, 
the maximum user interface clock is 
automatically set. 

Break condition mode Emulator (default) 

Flash memory synchronization Disable (default) 

Step Over option Programming of the flash memory (default) 

Flash memory write after download Disable (default) 

 

• Click the [OK] button to set a configuration. 
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6.5   Checking the Operation of RAM 

Check that RAM is operating correctly. 

Display and edit the contents of the memory in the [Memory] window to check that the memory is 
operating correctly. 

Note: The memory can be installed on the board in some microcomputers.  In this case, 
however, the above way of checking the operation of memory may be inadequate.  It is 
recommended that a program for checking the memory be created. 

• Select [Memory…] from the [CPU] submenu of the [View] menu and enter the RAM address 
in the [Display Address] edit box. Here, enter FB80 in the [Display Address] edit box. Then, 
enter 0000 and FFFF in the [Scroll Start Address] and [Scroll End Address] edit boxes, 
respectively. 

 

 

Figure 6.2   [Display Address] Dialog Box 

Note: The settings of the RAM area differ depending on the product. For details, refer to the 
hardware manual. 

• Click the [OK] button.  The [Memory] window is displayed and shows the specified memory 
area. 
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Figure 6.3   [Memory] Window 

• Placing the mouse cursor on a point in the display of data in the [Memory] window and 
double-clicking allows the values at that point to be changed. Data can also be directly edited 
around the current position of the text cursor. 
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6.6   Downloading the Tutorial Program 

6.6.1   Downloading the Tutorial Program 

Download the object program to be debugged. 

In this emulator, it is enabled to download the program and set the PC breakpoint in the internal 
flash memory area. For the method to set the PC breakpoint, refer to section 6.16.1, PC Break 
Function. 

• Select [Download module] from [Tutorial.abs] under [Download modules]. 
 

 

Figure 6.4   Downloading the Tutorial Program 
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6.6.2   Displaying the Source Program 

The High-performance Embedded Workshop allows the user to debug a user program at the 
source level. 

• Double-click [tutorial.cpp] under [C++ source file]. 

 

 

Figure 6.5   [Editor] Window (Displaying the Source Program) 

• Select the [Display] option from the [Tool] menu to set a font and size that are legible, if 
necessary. 

 
Initially the [Editor] window shows the start of the user program, but the user can use the scroll 
bar to scroll through the user program and look at the other statements. 
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6.7   Setting a PC Breakpoint 

A PC breakpoint is a simple debugging function. 

The [Editor] window provides a very simple way of setting a PC breakpoint at any point in a 
program.  For example, to set a PC breakpoint at the sort function call: 

• Select by double-clicking the [S/W breakpoint] column on the line containing the sort 
function call. 

 

 

Figure 6.6   [Editor] Window (Setting a PC Breakpoint) 

The symbol • will appear on the line containing the sort function.  This shows that a PC 
breakpoint has been set. 
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6.8   Setting Registers 

Set values of the program counter and the stack pointer before executing the program. 

• Select [Registers] from the [CPU] submenu of the [View] menu.  The [Register] window is 
displayed. 

 

 

Figure 6.7   [Register] Window 
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• To change the value of the program counter (PC), double-click the value area in the [Register] 
window with the mouse.  The following dialog box is then displayed, and the value can be 
changed.  Set the program counter to H’400 in this tutorial program, and click the [OK] button. 

 

 

Figure 6.8   [PC – Set Value] Dialog Box 
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6.9   Executing the Program 

Execute the program as described in the following: 

• To execute the program, select [Go] from the [Debug] menu, or click the [Go] button on the 
toolbar. 

 

 

Figure 6.9   [Go] Button 

When the program execution is started, ‘**RUNNING’ is displayed on the status bar.   

The program will be executed up to the breakpoint that has been set, and an arrow will be 
displayed in the [S/W breakpoint] column to show the position that the program has halted, with 
the message [BREAKPOINT] in the status bar. 

Note: When the source file is displayed after a break, a path of the source file may be inquired. 
The location of the source file is as follows: 
<Windows® drive>\Workspace\Tutorial\E7\xxxx\Tutorial\Tutorial\Source 
The directory xxxx varies depending on the device. 
<Windows® drive>\WorksSpace\Tutorial\E7\R8C\Tutorial\Tutorial\Source 
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Figure 6.10   [Editor] Window (Break State) 
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The user can see the cause of the break that occurred last time in the [Status] window. 

• Select [Status] from the [CPU] submenu of the [View] menu.  After the [Status] window is 
displayed, open the [Platform] sheet, and check the Status of Cause of last break. 

 

 

Figure 6.11   [Status] Window 

Note: The items that can be set in this window differ depending on the product. For the settings 
for each product, refer to the online help. 
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6.10   Reviewing Breakpoints 

The user can see all the breakpoints set in the program in the [Event] window. 

• Select [Eventpoints] from the [Code] submenu of the [View] menu.  The [Event] window is 
displayed.  Select the [Breakpoint] sheet. 

 

 

Figure 6.12   [Event] Window 

The popup menu, opened by clicking the [Event] window with the right-hand mouse button, 
allows the user to set or change breakpoints, define new breakpoints, and delete, enable, or 
disable breakpoints. 
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6.11   Viewing Memory 

When the label name is specified, the user can view the memory contents that the label has been 
registered in the [Memory] window.  For example, to view the memory contents corresponding to 
_main in word size: 

• Select [Memory …] from the [CPU] submenu of the [View] menu, enter _main in the 
[Display Address] edit box, enter 0000 in the [Scroll Start Address] edit box, and enter FFFF 
in the [Scroll End Address] combo box. 

 

 

Figure 6.13   [Format] Dialog Box 
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• Click the [OK] button. The [Memory] window showing the specified area of memory is 
displayed. 

 

 

Figure 6.14   [Memory] Window 
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6.12   Watching Variables 

As the user steps through a program, it is possible to watch that the values of variables used in the 
user program are changed.  For example, set a watch on the long-type array a declared at the 
beginning of the program, by using the following procedure: 

• Click the left of displayed array a in the [Editor] window to position the cursor. 

• Select [Instant Watch...] with the right-hand mouse button. 

 
The following dialog box will be displayed. 

 

Figure 6.15   [Instant Watch] Dialog Box 

• Click the [Add] button to add a variable to the [Watch] window. 

 

 

Figure 6.16   [Watch] Window (Displaying the Array) 
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The user can also add a variable to the [Watch] window by specifying its name. 

• Click the [Watch] window with the right-hand mouse button and select [Add Watch…] from 
the popup menu. 

 
The following dialog box will be displayed.  Enter variable i. 

 

Figure 6.17   [Add Watch] Dialog Box 

• Click the [OK] button. 

 
The [Watch] window will now also show the int-type variable i. 

 

Figure 6.18   [Watch] Window (Displaying the Variable) 
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The user can click mark ‘+’ at the left side of array a in the [Watch] window to watch all the 
elements. 

 

Figure 6.19   [Watch] Window (Displaying Array Elements) 
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6.13   Stepping Through a Program 

The High-performance Embedded Workshop provides a range of step menu commands that allow 
efficient program debugging. 

Table 6.2   Step Option 

Menu 
Command 

 
Description 

Step In Executes each statement, including statements within functions. 

Step Over Executes a function call in a single step. 

Step Out Steps out of a function, and stops at the statement following the statement in the 
program that called the function. 

Step… Steps the specified times repeatedly at a specified rate. 

 

6.13.1   Executing [Step In] Command 

The [Step In] command steps into the called function and stops at the first statement of the called 
function. 

• To step through the sort function, select [Step In] from the [Debug] menu, or click the [Step 
In] button on the toolbar. 

 

 

Figure 6.20   [Step In] Button 
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Figure 6.21   [Editor] Window (Step In) 

• The highlighted line moves to the first statement of the sort function in the [Editor] window. 
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6.13.2   Executing [Step Out] Command 

The [Step Out] command steps out of the called function and stops at the next statement of the 
calling statement in the main function. 

• To step out of the sort function, select [Step Out] from the [Debug] menu, or click the [Step 
Out] button on the toolbar. 

 
Note: It takes time to execute this function.  When the calling source is clarified, use [Go To 

Cursor]. 

 

Figure 6.22   [Step Out] Button 

 

Figure 6.23   [High-performance Embedded Workshop] Window (Step Out) 
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The data of variable a displayed in the [Watch] window is sorted in ascending order. 

6.13.3   Executing [Step Over] Command 

The [Step Over] command executes a function call as a single step and stops at the next statement 
of the main program. 

• To step through all statements in the change function at a single step, select [Step Over] from 
the [Debug] menu, or click the [Step Over] button on the toolbar. 

 

 

Figure 6.24   [Step Over] Button 

 

Figure 6.25   [High-performance Embedded Workshop] Window (Step Over) 
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6.14   Forced Breaking of Program Executions 

The High-performance Embedded Workshop can force a break in the execution of a program. 

• Cancel all breaks. 

• To execute the remaining sections of the main function, select [Go] from the [Debug] menu 
or the [Go] button on the toolbar. 

 

 

Figure 6.26   [Go] Button 

• The program goes into an endless loop.  To force a break in execution, select [Halt] from the 
[Debug] menu or the [Halt] button on the toolbar. 

 

 

Figure 6.27   [Halt] Button 
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6.15   Displaying Local Variables 

The user can display local variables in a function using the [Locals] window.  For example, we 
will examine the local variables in the main function, which declares four local variables: a, j, i, 
and p_sam. 

• Select [Locals] from the [Symbol] submenu of the [View] menu.  The [Locals] window is 
displayed. 

 
The [Locals] window shows the local variables in the function currently pointed to by the program 
counter, along with their values. Note, however, that the [Locals] window is initially empty 
because local variables are yet to be declared. 

 

Figure 6.28   [Locals] Window 

• Click mark ‘+’ at the left side of array a in the [Locals] window to display the elements. 

• When the user refers to the elements of array a before and after the execution of the sort 
function, it is clarified that random data is sorted in descending order. 
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6.16   Break Function 

The emulator has PC and hardware break functions.  With the High-performance Embedded 
Workshop, a PC breakpoint can be set using the [Breakpoint] sheet of the [Event] window, and a 
hardware break condition can be set using the [Breakcondition] sheet.  

An overview and setting of the break function are described below. 

6.16.1   PC Break Function 

The emulator can set up to 255 PC breakpoints.  Other methods for setting a PC breakpoint than in 
section 6.7, Setting a PC Breakpoint, are described below. 

• Select [Eventpoints] from the [Code] submenu of the [View] menu.  The [Event] window is 
displayed. 

• Select the [Breakpoint] sheet. 
 

 

Figure 6.29   [Event] Window (Before PC Breakpoint Setting) 
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• Click the [Event] window with the right-hand mouse button and select [Add…] from the 
popup menu. 

• Enter H'1070 in the [Address] edit box. 
 

 

Figure 6.30   [Set Break] Dialog Box 

Note: The address value to be entered differs in each product. Enter the value depending on the 
tutorial program. 

• Click the [OK] button. 
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The PC breakpoint that has been set is displayed in the [Event] window. 

 

Figure 6.31   [Event] Window (PC Breakpoint Setting) 

To stop the tutorial program at the PC breakpoint, the following procedure must be executed: 

• Close the [Event] window. 

• Set the program counter value (PC = H’400) that was set in section 6.8, Setting Registers, in 
the [Register] window.  Click the [Go] button. 

• If program execution is failed, reset the device and execute again the procedures above. 
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The program runs, and stops at the set PC breakpoint. 

 

Figure 6.32   [Editor] Window at Execution Stop (PC Break) 
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The [Status] window displays the following contents. 

 

Figure 6.33   Displayed Contents of the [Status] Window (PC Break) 

Note: The items that can be set in this window differ depending on the product. For the settings 
for each product, refer to the online help. 
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6.17   Hardware Break Function 

A method is given below in which the address bus condition is set under Break Condition 1 as 
hardware break conditions. 

• Select [Eventpoints] from the [Code] submenu of the [View] menu.  The [Event] window is 
displayed. 

• The PC breakpoint that has been previously set is deleted.  Click the [Event] window with the 
right-hand mouse button and select [Delete All] from the popup menu to cancel all PC 
breakpoints that have been set. 

• To set a Break condition 1, click the [Break condition] tab. 

• Select a line of Break condition 1 in the [Event] window.  When highlighted, double-click this 
line. 

 

 

Figure 6.34   [High-performance Embedded Workshop] Window ([Break condition 1]) 

• The [Break condition 1] dialog box is displayed. 
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• Clear the [Don't care] check box in the [Address] group box. 

• Select the [Only program fetched address after] radio button and enter H'1070 as the value in 
the [Address] edit box. 

 

 

Figure 6.35   [condition] Page ([Break condition 1] Dialog Box) 

• Click the [OK] button. 

• The first point display in the State column changes from Disable to Enable. 

• The first point display in the Condition column changes from None to Address = 
H’00001070 (Tutorial.cpp/47) pcafter. 

• Set the program counter value (PC = H’400) that was set in section 6.8, Setting Registers, in 
the [Register] window. Click the [Go] button. 

 
Notes: 1. The items that can be set in this page differ depending on the product. For the settings 

for each product, refer to the online help. 

 2. The address value to be entered differs in each product. Enter the value depending on 
the tutorial program. 
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The program runs and then stops at the condition specified under Break Condition 1. 

 

Figure 6.36   [Editor] Window at Execution Stop (Break Condition 1) 
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The [Status] window displays the following contents. 

 

Figure 6.37   Displayed Contents of the [Status] Window (Break Condition 1) 

Note: The items that can be set in this window differ depending on the product. For the settings 
for each product, refer to the online help. 
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6.18   Trace Functions 

The emulator has a branch-instruction trace function. 

The branch source addresses, mnemonics, operands, source lines, and labels are displayed for four 
branches. 

Note: For the trace functions, a trace buffer installed in the MCU is used. The trace function is 
unavailable for the MCU that does not have this function. 

6.18.1   Displaying the Trace Window 

Select [Trace] from the [Code] submenu of the [View] menu.   

Run the program as shown in the example of section 6.16.1, PC Break Function.  The trace results 
are displayed in the [Trace] window after the program execution is completed. 

 

Figure 6.38   [Trace] Window 

If necessary, adjust the column widths by dragging borders in the header bar (immediately below 
the title bar). 

Note: The number of branch instructions that can be acquired by a trace and the trace display 
differ depending on the product.  For the specification of each product, refer to the online 
help. 
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6.19   Stack Trace Function 

The emulator uses the information on the stack to display the names of functions in the sequence 
of calls that led to the function to which the program counter is currently pointing. 

Note: This function can be used only when the load module that has the Elf/Dwarf2-type 
debugging information is loaded.  Such load modules are supported in H8C/C++ compiler 
V3.0 or later. 

• Double-click the [S/W breakpoint] column in the sort function and set a PC breakpoint. 
 

 

Figure 6.39   [Editor] Window (PC Breakpoint Setting) 
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• Set the same program counter value (PC = H’400) as was set in section 6.8, Setting Registers 
(again, use the [Register] window).  Click the [Go] button. 

• After the break in program execution, select [Stack Trace] from the [Code] submenu of the 
[View] menu to open the [Stack Trace] window. 

 

 

Figure 6.40   [Stack Trace] Window 

Figure 6.40 shows that the position of the program counter is currently at the selected line of the 
sort() function, and that the sort() function is called from the tutorial() function. 
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6.20   What Next? 

This tutorial has described the major features of the emulator and the use of the High-performance 
Embedded Workshop. 

Sophisticated debugging can be carried out by using the emulation functions that the emulator 
offers.  This provides for effective investigation of hardware and software problems by accurately 
isolating and identifying the conditions under which such problems arise. 
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Appendix A   Components of the E7 Emulator 

Table A.1 lists the components of the Tiny/Super Low Power E7 emulator. 

Table A.1   Components of the Emulator (HS0007TCU01H) 

Classi-
fication 

 
Component 

 
Appearance 

Quan-
tity 

 
Remarks 

Hard- 
ware 

E7 emulator 

HS0007TCU01H 
(Model: HS0007TCU01H) 

1 HS0007TCU01H:  
Depth: 65 mm,  
Width: 97 mm,  
Height: 21 mm,  
Mass: 63.0 g 

 User system interface 
cable 

1 Length: 20 cm (connector 
part not included),  
Mass: 20.0 g 

 USB cable 1 Length: 1.5 m,  
Mass: 52.0 g 

Soft- 
ware 

Tiny/Super Low Power E7 
emulator setup program,  

Tiny/Super Low Power E7 
Emulator User’s Manual,  

Notes on Connecting the 
H8/xxxx,  
Notes on Connecting the 
R8C/xxxx 

E7 emulator test program,  

E7 Emulator Test Program 
Manual,  
 

R8C free compiler,  

and  

H8 free compiler 

1 HS0007TCU01SR,  

 
HS0007TCU01HJ,  
HS0007TCU01HE,  

HS0007TCU01HJPn,  
HS0007TCU01HEPn  
(n = 1, 2, 3, 4, …),  
 

E7TM.EXE, 

HS0007TM01HJ,  
HS0007TM01HE 
(provided on a CD),  

M3T-NC3C,  

and  

Provided with the 
Tiny/Super Low Power E7 
emulator setup program 
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Appendix B   Window Functions 

This section describes the window functions that can be used with the E7 emulator High-
performance Embedded Workshop. Here, the High-performance Embedded Workshop common 
functions are omitted, and only the emulation functions are described.  
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Table B.1   Window Functions 

 
Menu 

 
Option 

 
Shortcut 

Toolbar 
Button 

 
Remarks 

View Disassembly Ctrl + D 
 

Opens the [Disassembly] 
window. 

 Command Line Ctrl + L 
 

Opens the [Command Line] 
window. 

 TCL toolkit Shift + 
Ctrl + L  

Opens the [Console] window. 

 Workspace Alt + K 
 

Opens the [Workspace] 
window. 

 Output Alt + U 
 

Opens the [Output] window. 

 Difference   Opens the [Difference] 
window. 

 CPU Registers Ctrl + R 
 

Opens the [Register] window. 

  Memory… Ctrl + M 
 

Opens the [Memory] window. 

  IO Ctrl + I 
 

Opens the [IO] window. 

  Status Ctrl + U 
 

Opens the [Status] window. 

 Sym-
bol 

Labels Shift + 
Ctrl + A  

Opens the [Labels] window. 

  Watch Ctrl + W 
 

Opens the [Watch] window. 

  Locals Shift + 
Ctrl + W  

Opens the [Locals] window. 

 Code Eventpoints Ctrl + E 
 

Opens the [Event] window. 

  Trace Ctrl + T 
 

Opens the [Trace] window. 

  Stack Trace Ctrl + K 
 

Opens the [Stack Trace] 
window. 
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Table B.1   Window Functions (cont) 

 
Menu 

 
Option 

 
Shortcut 

Toolbar 
Button 

 
Remarks 

View 
(cont) 

Gra-
phic 

Image… Shift + 
Ctrl + G  

Opens the [Image] window. 

  Waveform… Shift + 
Ctrl + V  

Opens the [Waveform] window. 

Setup Radix Hexadecimal  
 

Uses a hexadecimal for 
displaying a radix in which the 
numerical values will be 
displayed and entered by default. 

  Decimal  
 

Uses a decimal for displaying a 
radix in which the numerical 
values will be displayed and 
entered by default. 

  Octal  
 

Uses an octal for displaying a 
radix in which the numerical 
values will be displayed and 
entered by default. 

  Binary  
 

Uses a binary for displaying a 
radix in which the numerical 
values will be displayed and 
entered by default. 

 Emu-
lator 

System…  
 

Opens the [Configuration 
Properties] dialog box allowing 
the user to modify the debugging 
platform settings. 

Debug Debug Sessions…   Opens the [Debug Sessions] 
dialog box to list, add, or remove 
the debug session. 

 Debug Settings…   Opens the [Debug Settings] 
dialog box to set the debugging 
conditions or download modules. 

 Reset CPU  
 

Resets the target hardware and 
sets the PC to the reset vector 
address. 

 Go F5 
 

Starts executing the user 
program at the current PC. 

 



132 

 

Table B.1   Window Functions (cont) 

 
Menu 

 
Option 

 
Shortcut 

Toolbar 
Button 

 
Remarks 

Debug 
(cont) 

Reset Go Shift + F5 
 

Resets the target microcomputer 
and executes the user program 
from the reset vector address. 

 Go To Cursor  
 

Starts executing the user 
program at the current PC until 
the PC reaches the address 
indicated by the current text 
cursor position. 

 Set PC To Cursor  
 

Sets the PC to the address at 
the row of the text cursor. 

 Run…   Launches the [Run Program] 
dialog box allowing the user to 
enter the PC or PC breakpoint 
during executing the user 
program. 

 Display PC Shift + 
Ctrl + Y  

Displays the current PC value. 

 Step In F11 
 

Executes a block of user 
program before breaking. 

 Step Over F10 
 

Executes a block of user 
program before breaking. If a 
subroutine call is reached, then 
the subroutine will not be 
entered. 

 Step Out Shift + 
F11  

Executes the user program to 
reach the end of the current 
function. 

 Step…   Launches the [Step Program] 
dialog box allowing the user to 
modify the settings for stepping. 

 Step 
Mode 

Auto   Steps only one source line when 
the [Editor] window is active. 
When the [Disassembly] window 
is active, stepping is executed in 
a unit of assembly instructions. 

  Assembly   Executes stepping in a unit of 
assembly instructions. 
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Table B.1   Window Functions (cont) 

 
Menu 

 
Option 

 
Shortcut 

Toolbar 
Button 

 
Remarks 

Debug 
(cont) 

Step 
Mode 
(cont) 

Source   Steps only one source line. 

 Halt Program Esc 
 

Stops the execution of the user 
program. 

 Initialize   Disconnects the debugging 
platform and connects it again. 

 Connect  
 

Connects the debugging 
platform. 

 Disconnect  
 

Disconnects the debugging 
platform. This option cannot be 
used in some products. 

 Save Memory As…   Saves an address area. 

 Verify Memory…   Verifies an address area. 

 Download Modules   Downloads the object program. 

 Unload Modules   Unloads the object program. 
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Appendix C   Command-Line Functions 

The emulator supports the commands that can be used in the command-line window. 

For details, refer to the online help. 
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Appendix D   Notes on High-performance Embedded 
Workshop 

1. Note on Moving Source File Position after Creating Load Module 

When the source file is moved after creating the load module, the [Open] dialog box may be 
displayed to specify the source file during the debugging of the created load module.  Select 
the corresponding source file and click the [Open] button. 

2. Source-Level Execution 

⎯ Source file 

Do not display source files that do not correspond to the load module in the program 
window.  For a file having the same name as the source file that corresponds to the load 
module, only its addresses are displayed in the program window.  The file cannot be 
operated in the program window. 

⎯ Step 

Even standard C libraries are executed.  To return to a higher-level function, enter Step 
Out.  In a for statement or a while statement, executing a single step does not move 
execution to the next line.  To move to the next line, execute two steps. 

3. Operation During Accessing Files 

Do not perform other operations during downloading the load module or saving in the [Verify 
Memory], [Save Memory], or [Trace] window because this will not allow correct file 
accessing to be performed. 

4. Watch 

⎯ Local variables at optimization 

Depending on the generated object code, local variables in a C source file that is compiled 
with the optimization option enabled will not be displayed correctly.  Check the generated 
object code by displaying the [Disassembly] window.   
If the allocation area of the specified local variable does not exist, displays as follows. 

  Example: The variable name is asc. 

    asc = ?  - target error 2010 (xxxx) 

⎯ Variable name specification 

When a name other than a variable name, such as a symbol name or function name, is 
specified, no data is displayed. 
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  Example: The function name is main. 

    main =  

It is not possible to set variables that have been allocated to registers. 

⎯ Variable update 

For updating of the content of the variable that has been registered in the [Watch] window, 
read the data after the break in user program execution. The realtime operation for the user 
program is disabled because the user program is temporarily stopped. 

5. Line Assembly 

⎯ Input radix 

Regardless of the Radix setting, the default for line assembly input is decimal.  Specify H’ 
or 0x for the H8 series microcomputers and xxxxh for the R8C series microcomputers as 
the radix for a hexadecimal input. 

6. Command Line Interface 

⎯ Batch file 

To display the message “Not currently available” while executing a batch file, enter the 
sleep command.  Adjust the sleep time length which differs according to the operating 
environment. 

Example: To display “Not currently available” during memory_fill 
execution: 

    sleep d’3000 

    memory_fill 0 ffff 0 

⎯ File specification by commands 

The current directory may be altered by file specifications in commands.  It is 
recommended to use absolute paths to specify the files in a command file so that the 
current directory alteration is not affected. 

Example: FILE_LOAD C\HEW\Tools\Renesas\DebugComp\Platform\E7 
\Tutorial\Debug_Tiny_SLP_E7_SYSTEM\Tutorial.abs 

7. Memory Save During User Program Execution 

Do not execute memory save or verifying during user program execution. 
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8. Load of Motorola S-type Files 

This High-performance Embedded Workshop does not support Motorola S-type files with only 
the CR code (H'0D) at the end of each record. Load Motorola S-type files with the CR and LF 
codes (H'0D0A) at the end of each record. 

9. [I/O] window 

⎯ Display and modification 

Do not change values in the [I/O Registers] window because the emulator uses the address 
break controller. 

⎯ Note that the E7 emulator does not support the display of the invalid module or bit 
information in the [I/O] window. 

10. Note on [Register] Window Operation During Program Execution 

The register value cannot be changed in the [Register] window during program execution. 
Even if the changed value is displayed, the register contents are not changed actually. 

11. Using Register Contents 

Use the value contained in a CPU register by specifying the register name prefixed by the “#” 
character, e.g.: #R1, #PC, #R6L, or #ER3 when you are entering a value elsewhere in the 
High-performance Embedded Workshop, for example when displaying a specified address in 
the [Disassembly] or [Memory] window. 
In the R8C/Tiny, specify and enter the bank number before a register name; e.g., #0R0 or 
#0R0H. 

12. Break Functions 

⎯ When the PC breakpoint is set in the flash memory area, the program is written to the flash 
memory each time the user program is executed.  At this time, note that the number of 
rewritable times will be decreased. 

⎯ BREAKPOINT cancellation 

When the contents of the BREAKPOINT address is modified during user program 
execution, the following message is displayed when the user program stops. 

 BREAKPOINT IS DELETED A=xxxxxxxx 

If the above message is displayed, cancel all BREAKPOINT settings with the [Delete All] 
or [Disable] button in the [Breakpoints] window. 
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13. Number of BREAKPOINT and [Stop At] Settings in the [Run...] Menu  

The maximum number of BREAKPOINTs and [Stop At] settings allowed in the [Run...] menu 
is 255.  Therefore, when 255 BREAKPOINTs are set, specification by [Stop At] in the [Run...] 
menu becomes invalid.  Use the BREAKPOINTs and [Stop At] in the [Run...] menu with 255 
or less total settings. 

14. Note on RUN-TIME Display 

The execution time of the user program displayed in the [Status] window is not a correct value 
since the timer in the host computer has been used. 

15. Note on Displaying Timeout error 

If Timeout error is displayed, the emulator cannot communicate with the target 
microcomputer.  Turn off the emulator and the user system and connect the emulator again by 
using the High-performance Embedded Workshop. 

16. Support of Double Float Format 

In the following memory operations, the double float format is not supported: 

⎯ [Fill Memory] dialog box 

⎯ [Search Memory] dialog box 

⎯ MEMORY_FILL command 

The [Format] specification in the [Copy Memory] dialog box is ignored.  Memory is 
copied in a byte unit. 

17. Note on Using the [Run Program] Dialog Box 

When [Run...] is selected from the [Debug] menu to specify the stop address, there is the 
following note: 

⎯ When the breakpoint that has been set as Disable is specified as the stop address, note that 
the breakpoint becomes Enable when the user program stops. 

18. [Stack Trace] Window 

When using the NC30WA or NC8C, if parameters and local variables of a function are 
referred in the call stack window and one or more parameters are on a register, the register 
parameters may be interchanged with the local variables. However, the correct values are 
displayed. 

19. Memory Access during User Program Execution 

When a memory is accessed from the memory window, etc. during user program execution, 
the user program is resumed after it has stopped in the E7 emulator to access the memory.  
Therefore, realtime emulation cannot be performed.  
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20. Internal Flash Memory 

The actual MCU, which has been used by connecting to the emulator, has been programmed to 
the flash memory at emulation and stressed.  Do not use the MCU that has been used for 
debugging for the mass products.  If the MCU has not been used for debugging, the emulator is 
also available as the programming tool for mass production. 

21. Suspend during Emulator Use 

Do not set the host computer as the suspend mode while using the emulator. If the host 
computer enters the suspend mode, exit and restart the High-performance Embedded 
Workshop. 

22. Verification of Memory 

Use the FILE_VERIFY command to verify memory. Do not use [Verify Memory…] in the 
[File] menu. 

23. Overwrite of a File 

In command line interface, a file that has the same name as the output file is overwritten 
without asking the user. 

24. Usage with Other Products 

To install the SuperH™ RISC engine C/C++ compiler package or H8, H8/300 series C/C++ 
compiler package after installing the emulator software for High-performance Embedded 
Workshop, select [High-performance Embedded Workshop] as the component to be installed 
in [Select Components] during installation of the compiler package. 

25. Download of Load Modules 

When load modules are downloaded, select [Debug] -> [Download] -> [All DownLoad 
Modules]. 

26. Writing Flash Memory Mode 

When microcomputers are continuously programmed, be sure to turn the target on or off. 

27. Memory Access in the Writing Flash Memory Mode 

Memory cannot be accessed in the Writing Flash Memory mode. In this mode, values 
displayed in the [Memory] or [IO] window are dummy. 

28. Memory Access during Flash Memory Programming 

During flash memory programming (e.g., user program execution), operation for memory 
accessing such as opening the [Memory] window is not allowed. Values displayed here are 
dummy. Access the memory again after flash memory programming has been completed. 
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Appendix E   Diagnostic Hardware Program 

This section describes the troubleshooting procedure that applies the diagnostic program for the 
emulator. 

E.1   Setting Up the System to Execute the Diagnostic Program 

(1) The following equipments are required to execute the diagnostic program. Do not connect the 
user system interface cable or the user system while the diagnostic program is running: 

• E7 emulator main unit 

• USB cable included with the emulator 

• CD included with the emulator 

• Host computer 
 

Install the High-performance Embedded Workshop and USB driver on the host computer in 
advance. 

 
(2) Start the host computer and connect the emulator to the USB connector of the host computer 

via the USB cable provided. Prior to this, the user system interface cable must be disconnected. 
 
(3) Copy the [E7SCP] folder in the CD included with the emulator into an arbitrary folder in the 

host computer. 
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E.2   Executing the Diagnostic Program 

(1) Start up [E7TM.EXE] in the [E7SCP] folder copied to an arbitrary folder. 

 

Figure E.1   Starting the Diagnostic Program 



145 

 

(2) Click the [START] button. The message [RUNNING] is displayed on the window and the 
diagnostic program is executed. 

 

Figure E.2   Executing the Diagnostic Program 
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(3) The message [FAIL] or [PASS] will be displayed. The [PASS] indicates that the emulator is 
working correctly. Click the [QUIT] button to exit the diagnostic program. 

 

Figure E.3   Exiting the Diagnostic Program 
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E.3   Handling Errors 

(1) If [FAIL] is displayed during execution of the diagnostic program, a status number is also 
displayed at the right bottom of the window. 

(2) Click the [LOG] button to create a log file. 

 

Figure E.4   [FAIL] Message 

(2) Send a file [E7TM_LOG.TXT], which has been created in the folder where ‘E7TM.EXE’ was 
executed, to our customer support center by e-mail. The e-mail address is written on the 
following website: 
Renesas Tool Homepage: http://www.renesas.com/en/tools 
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